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Appendix D – COTS/GOTS SAMPLE Installation 
Instructions 

  
1. Software Installation Requirements  

A.) Solaris 2.6 System 
B.) Solaris 7 System 
C.) Common to the Solaris 2.6 and Solaris 7 Operating 
Systems 

2. Performing a Full System Backup To Tape 
3. Resizing Disk Partitions and Full Restore From Tape 
4. Sample Broadsword Gatekeeper Disk Partitions  
5. Sample TTA Gatekeeper Disk Partitions  
6. Installing the Solaris Operating System 

A.) Solaris 2.6 Installation Instructions (excluding Sun Ultra 
80) 
B.) Solaris 2.6 Installation Instructions on Sun Ultra 80 
C.) Solaris 7 Installation Instructions on all systems 
D.) Upgrading to Solaris 7 from Solaris 2.6 
E.) Raptor Graphics Installation Instructions 

7. Installing Solaris Patches 
A.) Solaris 2.6 Patches Installation Instructions 
B.) Solaris 7 Patches Installation Instructions 

8. Installing Solaris Utilities 
A.) Adobe 4 Installation Instructions  
B.) Netscape Communicator 4.76 Installation Instructions  
C.) GZIP 1.3 Installation Instructions  
D.) LSOF 4.45 Installation Instructions  
E.) MPEG Play 2.0 Installation Instructions  
F.) TCSH 6.09.00 Installation Instructions  
G.) Top 3.5 Installation Instructions  
H.) Traceroute 1.4 Installation Instructions 
I.) UNZIP 5.4 Installation Instructions 
J.) Xanim 2.70.6.3 Installation Instructions 
K.) XV 3.10 Installation Instructions 

9. Miscellaneous Configuration 
A.) Automount Configuration 
B.) DNS Configuration 
C.) Default Router Configuration 
D.) Netmasks Configuration 

10. Sybase Adaptive Server 11.5.1 and 11.9.2 Installation Instructions 
11. CSE-SS Installation Instructions 

A.) Solaris 2.6 and Solaris 7 
B.) Upgrading from Solaris 2.6 to Solaris 7 

12. CSE-SS Patches Installation Instructions 
13. AFDI 1.1 for Solaris 7 Installation Instructions 
14. Installing the Java Runtime Environment (JRE) v 1.3.1 
15. General Trouble-Shooting & Miscellaneous 
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1.) Software Installation Requirements 
 
All software referenced in this section is available in the Broadsword Installers Kit for Broadsword PMO 
installation personnel.  Information is provided for non-Broadsword PMO installation personnel where this 
software may be obtained.  The Broadsword PMO makes every effort to ensure the validity of these 
sources, however, due to the rapidly changing nature of this information we cannot guarantee software is 
always available through these sources. 
 
Caution:  While downloading and "burning" any freeware to a CD or any other media, you MUST ensure 
your system does NOT CHANGE any of the original FILENAMES as they appeared when downloaded.  
You may need to ENABLE LONG FILENAME and ISO COMPATIBILITY. 
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A.) Solaris 2.6  
The following software requirements are specific to Broadsword systems that will be installed on the 
Solaris 2.6 operating system. 
 
• Operating Environment Installation CD, September 1999 

This CD is for used in conjunction with Solaris 2.6 CD, Software: 5/98 when installing on an Ultra 80 
or systems with a processor speed over 450 MHz.  As with every rule there are exceptions, check with 
your systems administrator or hardware personnel for additional information.  You may need to 
purchase this item.  Check with your local Sun Representative. 
 

• Solaris 2.6 Software: 5/98 
This is typically provided with the purchase of a Sun system.  You may need to purchase this item.  
Check with your local Sun Representative. 
 

• Solaris 2.6 Recommended and Y2K patches 
These patches are required if loading Solaris 2.6 CD, Software: 5/98 and can be downloaded from Sun 
at: 
http://www.sun.com/bigadmin/patches/indexLnk.html    
Once there click on the Public Patch Page link.  Select Solaris 2.6 from both Recommended Solaris 
Patch Clusters and Y2K Patch Clusters. 
 

• CSE-SS Version 1.4.2.1 for Solaris 2.6/2.7 
Recommended if loading Solaris 2.6 and can be requested by sending an email to CSE@rl.af.mil 
 

• Broadsword 3.1 Full Installation for Solaris 2.6 
Required if loading Solaris 2.6 CD, Software: 5/98.  This is provided by the Broadsword PMO.  If you 
require a copy, you can call commercial 315-330-4347 or DSN 587-4347. 
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B.) Solaris 7  
The following software requirements are specific to Broadsword systems that will be installed on the 
Solaris 7.0 operating system. 
 
• Solaris 7 Software: 11/99 

This is typically provided with the purchase of a Sun system.  You may need to purchase this item.  
Check with your local Sun Rep. 
 

• Solaris 7 Recommended patches 
These patches are required if loading Solaris 7 CD, Software: 11/99 and can be downloaded from Sun 
at:  
http://www.sun.com/bigadmin/patches/indexLnk.html 
Once there click on the Public Patch Page link.  Select Solaris 7 from both Recommended Solaris 
Patch Clusters. 
 

• CSE-SS Version 1.4.2.1 for Solaris 2.6/2.7 
Can be requested by sending an email to CSE@rl.af.mil 
   OR 

• AFDI Version 1.1 for Solaris 7 
Recommended if loading Solaris 7 and can be requested by sending an email to afdi@rl.af.mil 

 
• Broadsword 3.1 Full Installation for Solaris 7 

Required if loading Solaris 7 CD, Software: 11/99.  This is provided by the Broadsword PMO.  If you 
require a copy, you can call commercial 315-330-4347 or DSN 587-4347. 
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C.) Common to the Solaris 2.6, and Solaris 7 Operating Systems 
 
• Raptor GFX 2.1 

This is only required for selected servers, primarily, but not limited to Enterprise 250's and 450's.  
Check manufacturer’s guide for details. This is typically provided with the purchase of a Sun system. 
You may need to purchase this item.  Check with your local Sun Rep. 
 

• Netscape 4.76 or higher 
This can be downloaded from Netscape on the Internet at: 
http://home.netscape.com/download/archive/client_archive47x.html   
Once there, select the desired version and language for Solaris 2.5.1 and then click on the download 
link next to it.  This document used Solaris 2.5.1 – Complete Install (128-bit encryption) 
If you prefer to download if from the SIPRNet go to: 
http://help.ismc.sgov.gov/cgi-bin/software/index.pl?dir=Browser&path=pub/Browsers 
Scroll down to Netscape Communicator 4.76 for Solaris 2.5.1 and click on the Download button.  
Follow the instructions listed on the page. 
 

• Sybase Adaptive Server 11.5.1 or 11.9.2 
Required for Broadsword.  Site is responsible for purchasing and licensing this software 
 

• Broadsword Computer Based Training (CBT) v3.1 
This is provided by the installer.  If you require a copy, you can call commercial 315-330-4347 or DSN 
587-4347. 
 

• Broadsword Documentation v3.1 
This is provided by the installer.  If you require a copy, you can call commercial 315-330-4347 or DSN 
587-4347. 
 

• Miscellaneous Software 
Miscellaneous Utilities are freeware and can be downloaded off the Internet. This software is optional 
and is not needed for installation of Broadsword. This may include but not limited to the following 
applications: 
 

 
 

Note:  The location of these applications are subject to change and is not under the control of the Broadsword 
Program Office. 
 
 
• Adobe 4.05 

This can be downloaded from Adobe on the Internet at: 
http://www.adobe.com/products/acrobat/alternate.html#50enu  
Scroll down to Acrobat 4.05 Reader and click on Acrobat Reader 4.05 – English for Sun Solaris 
– Sparc (.tar.gz) 6.4MB 
If you prefer to download if from the SIPRNet go to: 
http://help.ismc.sgov.gov/cgi-bin/software/index.pl?dir=Solaris&path=pub/Solaris  
Scroll down to Adobe Acrobat Reader Sun Solaris SPARC Freeware Version 4.05 – (20010926) 
and click on the Download button.  Follow the instructions listed on the page. 
 

• GZIP 1.3 
This can be downloaded from the Internet at: 
http://sunfreeware.com 
In the top right window frame click on the SPARC/Solaris 6 or 7 link.  In the bottom right 
window frame scroll down and click on gzip-1.3.  In the center window frame click on the  
gzip-1.3.tar.gz. 
If you prefer to download it from the SIPRNet go to: 
http://help.ismc.sgov.gov/cgi-bin/software/index.pl?dir=UnixSource&path=pub/UnixSource 
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Scroll down to Gzip 1.2.4 and click on the Download button.  Follow the instructions listed on the 
page. 
 
 

• LSOF 4.45 
This can be downloaded from the Internet at: 
http://sunfreeware.com 
In the top right window frame click on the SPARC/Solaris 6 or 7 link.  In the bottom right 
window frame scroll down and click on lsof-4.45-32-bit.  In the center window frame click on the 
lsof-4.45.tar.gz. 
If you prefer to download it  from SIPRNet go to: 
http://www.66mi.army.smil.mil/pub/software/unix/ 
Scroll down and click on the hyperlink for lsof-4.33.tar.gz 
 

• MPEG Play 2.0 
This can be downloaded from the Internet at: 
http://sunfreeware.com 
In the top right window frame click on the SPARC/Solaris 6 or 7 link.  In the bottom right 
window frame scroll down and click on mpeg_play-2.0.  In the center window frame click on the 
mpeg_play-2.0.tar.gz. 
If you prefer to download it from SIPRNet go to: 
http://help.ismc.sgov.gov/cgi-bin/software/index.pl?dir=Applications&path=pub/UnixSource/Applications  
Scroll down to MPEG-2.3 player for Unix and click on the Download button.  Follow the 
instructions listed on the page. 
 

• TCSH 6.08.00 
This can be downloaded from the Internet at: 
http://sunfreeware.com 
In the top right window frame click on the SPARC/Solaris 6 or 7 link.  In the bottom right 
window frame scroll down and click on tcsh-6.08.00.  In the center window frame click on the 
tcsh-6.08.tar.gz. 
If you prefer to download it from SIPRNet go to: 
http://www.66mi.army.smil.mil/pub/software/unix/  
Scroll down and click on the hyperlink for tcsh-6.08.tar.gz. 
 

• TOP 3.5 
This can be downloaded from the Internet at: 
http://sunfreeware.com 
In the top right window frame click on the SPARC/Solaris 6 or 7 link.  In the bottom right 
window frame scroll down and click on top-3.5beta12.  In the center window frame click on the 
top-3.5beta12.tar.gz. 
If you prefer to download it from SIPRNet go to: 
http://help.ismc.sgov.gov/cgi-bin/software/index.pl?dir=Applications&path=pub/UnixSource/Applications  
Scroll down to Top CPU Usage Display version3.5 Beta9 and click on the Download button.  
Follow the instructions listed on the page. 
 

• TRACEROUTE 1.4 
This can be downloaded from the Internet at: 
http://sunfreeware.com 
In the top right window frame click on the SPARC/Solaris 6 or 7 link.  In the bottom right 
window frame scroll down and click on traceroute-1.4a5.  In the center window frame click on 
the traceroute-1.4a5.tar.gz. 
If you prefer to download it from SIPRNet go to: 
http://www.66mi.army.smil.mil/pub/software/unix/  
Scroll down and click on the hyperlink for traceroute-1.17.tar.gz. 
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• UNZIP 5.40 
This can be downloaded from the Internet at: 
http://sunfreeware.com 
In the top right window frame click on the SPARC/Solaris 6 or 7 link.  In the bottom right 
window frame scroll down and click on unzip-5.40.  In the center window frame click on the 
unzip-5.40.tar.gz. 
Not currently available on the SIPRNet. 
 

• Xanim 2.70.6.3 
This can be downloaded from the Internet at: 
http://sunfreeware.com 
In the top right window frame click on the SPARC/Solaris 6 or 7 link.  In the bottom right 
window frame scroll down and click on xanim-2.70.6.3.  In the center window frame click on the 
xanim-2.70.3.tar.gz. 
If you prefer to download it from SIPRNet go to: 
http://help.ismc.sgov.gov/cgi-bin/software/index.pl?dir=Applications&path=pub/UnixSource/Applications  
Scroll down to Xanim 2.70.7.0 and click on Download button.  Follow the instructions listed on 
the page. 
 

• XV 3.10 
This can be downloaded from the Internet at: 
http://sunfreeware.com 
In the top right window frame click on the SPARC/Solaris 6 or 7 link.  In the bottom right 
window frame scroll down and click on xv-3.10a.  In the center window frame click on the xv-
3.10a.tar.gz. 
If you prefer to download it from SIPRNet go to: 
http://help.ismc.sgov.gov/cgi-bin/software/index.pl?dir=Applications&path=pub/UnixSource/Applications  
Scroll down to XV 3.10a Source and click on Download button.  Follow the instructions listed on 
the page. 
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2.) Performing a Full System Backup to Tape 
 
Required Media: 1 – 4 Blank Tapes 
Required Hardware: Appropriate format tape drive 
 
 NOTE:   

• These procedures are not provided to dictate procedures/policies, but rather to provided a method for 
performing system backups to those site that do not currently have a method in place.  Tailor these procedures 
to fit your sites requirements, policies and/or needs. 

• These procedures assume Broadsword has been loaded in the default location (/opt/bswd3.1) 
• The number of tapes required depends on the amount of information of the server.  You will need to adjust 

these instructions accordingly to fit your sites needs. 
• These instructions assume your Broadsword Server is loaded with the recommended partition configurations 

found the in Appendix D of the Broadsword 3.1 Installation and Maintenance Guide.  If your site has a 
different configuration, ensure you modify these instructions to reflect your site's configuration. 

• These instructions assume the system has an attached tape drive, which is not a standard part of a Sun Server. 
It may be purchased when the server is purchased or at some later time. 

 
 
 
 
 
 
 
 
 
 
A.) The Backup Concept 
 
Regular backups of the UNIX file system is one of the most neglected, but more critical system 
administration functions.  File system backups can restore data and configurations lost due to hardware or 
software failures, reinstallation or upgrade failures, and even the occasion accidental deletions. 
 
The preferred method of performing a backup is to use the ufsdump command that is part of the Solaris 
Operating System.  The nature of this command allows the system administrator to perform complete or 
incremental backups of the entire file system or specific portions of the file system.  All initial backups of a 
system should include the entire file system.  This is referred to as a "Level 0 Dump” 
 
B.) Checking for Active Users 
 
Begin by logging into the server with a system administrator level account (cisso, cadmin, personal site 
approved account, etc.).  Once in launch a web browser and navigate to the Broadsword login page 
pertaining to the system you are about to backup.  When the Broadsword Login page appears, login as 
bswduser or any other account with Broadsword Administration access.  Once you have successfully 
logged in click on the Administration menu and select System Status.  From the System Status submenu 
select Current Users.  This will bring up the Current Users status page.  Ensure there are no users on the 
system prior to bringing the server down into single user mode.  Doing so while a user is still on-line may 
result in the loss of time critical data for that user.  Once you have determined there are no users on-line, 
click on the Session menu and select Exit.   
 
C.) Terminating the Broadsword and Sybase Processes 
 
Open a command shell window.  To do this right click anywhere on the Desktop.  This will bring up the 
Desktop Menu.  From the Desktop Menu, click on the Tools submenu and select Terminal.  When the 
terminal window appears assume root by typing: 
 
 su – <cr> 
 
When prompted, enter the appropriate password for the root user.  When the root prompt appears stop the 
Broadsword and Sybase processes by typing: 
 
 /opt/bswd3.1/scripts/stopserver <cr> 
 

 
 NOTE:  This step assumes you have loaded Broadsword in the default location. If Broadsword is loaded in a different 
location, the “stopserver” script will be found in the scripts directory under the bswd3.1 directory. 
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Assuming that the system has not been installed with a shared SYBASE dataserver (e.g., co-located with an 
IPL datasource), follow these steps to shut down the system: 
 

When prompted, "Default BSWD Shutdown? (Y.N) [Y]", press the [Return] key to accept the 
default of yes.  Next you will be prompted, "Stop these portions of BSWD? (Y/N) [Y]", press the 
[Return] key to accepted the default of yes.  At this time all Broadsword and Sybase processes will be 
halted. 

 
If the system has been installed with a shared SYBASE dataserver, (e.g., co-located on the same machine 
as an IPL datasource), follow these steps to shut down the system: 
 

When prompted, "Default BSWD Shutdown? (Y.N) [Y]", press the ‘N’ key.  Next you will be 
prompted, “Stop the Sybase dataserver? (Y/N) [Y]”, press the ‘N’ key. Another prompt will be 
displayed, “Stop the Broadsword background processes? (Y/N) [Y]”, press the [Return] key to accept 
the default of yes. A final prompt will be displayed - "Stop these portions of BSWD? (Y/N) [Y]", 
press the [Return] key to accepted the default of yes.  At this time all Broadsword processes will be 
halted. Continue with the other system’s recommended shutdown sequence. 

 
D.) Booting into single user mode 
 
The next task is to bring the system down to single user mode.  This is done to protect the data from being 
changed or corrupted  by users while the system administrator is trying to backup the data.  To bring the 
system down to the single user mode type: 
 
 init 0 <cr> 
 
This will bring the system down to the OpenBoot prompt or OK prompt.  To boot into single user mode 
from the OpenBoot prompt, type: 
 
 boot –s <cr> 
 
At this time the system will begin booting into single user mode.  If you have enabled the Firmware 
Password during the installation of AFDI or any other application / procedure that required you to do so, 
then you will be prompted for this password next.  Just prior to entering single user mode you will be 
prompted for a Maintenance or root password.  You will enter the root password at this time.  Once the root 
prompt appears verify you are in single user mode by typing: 
 
 who –r <cr> 
 
which should indicate a “run-level” of “S” or “s”. 
 
E.) Cleaning the File System prior to backup 
 
Before cleaning up the file system you will need to mount all file systems that will be backed up.  To do 
this type: 
 
 mountall –F ufs <cr> 
 
The next step is to find, identify and remove any core files on the system.  To do this type: 
 
 find / -type f –name core –print –exec file {} \; -exec rm {} \; 
<cr> 
 
To ensure the file system is clean run a file system check.  To do this type: 
 
 fsck <cr> 
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 NOTE:  If prompted to remove or delete answer no.  If prompted to fix, adjust or salvage answer yes. 

 
F.) Performing a Level 0 Dump 
 
Prepare and label your first tape as "Broadsword UFS DUMP".  Make sure the tape is write enabled, then 
insert it into the drive. 
 

 
 
NOTE:  The number of tapes required depends on the amount of information on the server.  You will need to adjust 
these instructions accordingly to fit your sites needs.
 
Next, verify the tape is useable.  To do this type: 
 
 mt –f /dev/rmt 0 stat <cr> 
 
 
 
 
 
 
 

NOTE:   
• The remaining portions of these instructions assume your Broadsword Server is loaded with the recommended 

partition configurations found in Appendix D of the Broadsword 3.1 Installation and Maintenance Guide.  If 
your sire had a different configuration, ensure you modify these instruction according to your sites 
configuration prior to continuing. 

• Unless otherwise noted, assume any large ‘0’ to be a zero, as compared to a capital ‘o’.  

 
Begin backing up your file partitions starting with the root partition.  To do this type: 
 
 ufsdump 0ubf 96 /dev/rmt/0n / <cr> 
 
When the prompt returns, backup the first sybase devices partition.  To do this type: 
 
 ufsdump 0ubf 96 /dev/rmt/0n /syb_devices_0 <cr> 
 
When the prompt returns, backup the /usr partition.  To do this type: 
 
 ufsdump 0ubf 96 /dev/rmt/0n /usr <cr> 
 
When the prompt returns, backup the first security partition.  To do this type: 
 
 ufsdump 0ubf 96 /dev/rmt/0n /security1 <cr> 
 
When the prompt returns, backup the /opt partition.  To do this type: 
 
 ufsdump 0ubf 96 /dev/rmt/0n /opt <cr> 
 
At this point we will assume the tape is nearly full.  That means its time to switch tapes.  First you will need 
to rewind the tape.  To do this type: 
 
 mt –f /dev/rmt/0 rew <cr> 
 
Advance the tape to the end in order to read the number of records on the tape in the next step.  To do this 
type: 
 
 mt –f /dev/rmt/0n eom <cr> 
 
Verify the number of records in status match the number of partitions backed up to the this point.  To do 
this type: 
 
 mt –f /dev/rmt/0n stat <cr> 
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 NOTE:  To this point, if you have not deviated from these instructions you should have a total of 5 records on the tape.

 
 
Once you have verified the number of records, rewind and eject the tape.  To do this type: 
 
 mt –f /dev/rmt/0n rewoff <cr> 

 
 NOTE:  The tape will automatically eject when it is finished rewinding.

 
Take the tape from the tape drive and write protect it.  Verify the tape has an appropriate security 
classification sticker on it, then enter today's date in pencil.  Prepare and label your second tape as 
"Broadsword UFS DUMP".  Make sure the tape is write enabled, then insert it into the drive. 
 
Next, verify the tape is useable.  To do this type: 
 
 mt –f /dev/rmt 0 stat <cr> 
 
Begin backing up your file partitions again starting with the /var partition.  To do this type: 
 
 ufsdump 0ubf 96 /dev/rmt/0n /var <cr> 
 
When the prompt returns, backup the second sybase devices partition.  To do this type: 
 
 ufsdump 0ubf 96 /dev/rmt/0n /syb_devices_1 <cr> 
 
When the prompt returns, backup the second security partition.  To do this type: 
 
 ufsdump 0ubf 96 /dev/rmt/0n /security2 <cr> 
 
When the prompt returns, backup the /h partition.  To do this type: 
 
 ufsdump 0ubf 96 /dev/rmt/0n /h <cr> 
 
 
 
 
 

NOTE:  If you used a four hard drive configuration on your system as per Appendix D of the Broadsword 3.1 
Installation and Maintenance Guide, then you may have additional partitions to backup.  If so swap tapes again and 
backup any remaining partitions using previous steps as a guide line.   Modify these instructions to reflect all changes. 

When the prompt returns, you should be finished with your Level 0 Dump.  Rewind the tape.  To do this 
type: 
 
 mt –f /dev/rmt/0 rew <cr> 
 
Advance the tape to the end in order to read the number of records on the tape in the next step.  To do this 
type: 
 
 mt –f /dev/rmt/0n eom <cr> 
 
Verify the number of records in status match the number of partitions backed up to the this point.  To do 
this type: 
 
 mt –f /dev/rmt/0n stat <cr> 
 

 NOTE:  To this point, if you have not deviated from these instructions you should have a total of 4 records on the tape.

 
 
Once you have verified then umber of records, rewind and eject the tape.  To do this type: 

                                                                                                                               D-11 



Broadsword-3.1-SYSIMG-20 Sept 02 
FINAL 

 
 
 mt –f /dev/rmt/0n rewoff <cr> 
 
 
 
NOTE:  The tape will automatically eject when it is finished rewinding.

Take the tape from the tape drive and write protect it.  Verify the tape has an appropriate security 
classification sticker on it, then enter today's date in pencil. Also, label the tapes used in the backup 
procedure as being 1 of (total number of tapes), 2 of (total number), etcetera. 
 
G.) Bringing the Server Back On-Line 
 
Next reboot the server and ensure it is online and functional.  To do this type: 
 

init 0 <cr> 
 
When the OK prompt appears type: 
 
 boot <cr> 
 
When the login screen appears, log into the server with a system administrator level account (cisso, cadmin, 
personal site approved account, etc.). Open a command shell window.  To do this right click anywhere on 
the Desktop.  This will bring up the Desktop Menu.  From the Desktop Menu, click on the Tools submenu 
and select Terminal.  When the terminal window appears assume root by typing: 
 
 su – <cr> 
 
When prompted, enter the appropriate password for the root user.  When the root prompt appears verify the 
Broadsword and Sybase processes are running by typing: 
 
 /opt/bswd3.1/scripts/whoserver <cr> 
 
 
 
 
 
 

NOTE:   
• This step assumes you have loaded Broadsword in the default location. 
• Other scripts and commands from this point on may have a capital ‘o’ instead of the zero character without 

warning. 

When prompted, "Enter the SA password to check SYBASE Free Space", press the [RETURN] key.  If all 
the processes are running you are finished.  
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3.) Resizing Disk Partitions and Full Restore From Tape 
 
Required Media: Solaris 2.6 CD, Software: 5/98 (to repartition and restore a Solaris 2.6 system) 

Solaris 7 CD, Software: 11/99 (to repartition and restore a Solaris 7 system) 
Full Backup (Level 0 Dump) Tape(s) 
 

This section provides an example how to resize partitions on an existing Broadsword system to be 
consistent with the partition guidelines provided in this document and then to restore the system using a full 
backup from tape.  Subsequent sections are to be performed while booted from CDROM. 
 

 
 
 

Note:  Do not proceed unless you have already performed a Full Backup on the system that will be repartitioned and 
restored.  Please refer to the Broadsword Gatekeeper Full Backup Procedure section in this appendix for an example 
how to create a full backup tape.
 
 
Insert the CD into the CDROM drive and boot the system from the CDROM Drive.   
 

boot cdrom<cr> 
 
It may take a few minutes for the initial screen to appear. 
 
A. Resizing Disk Partitions  
 
Select “Utilities/Command Tool” from the main menu to start a command tool window.  It is not necessary 
to proceed through any of the Solaris installation screens.  All commands will be executed from within the 
Command Tool window.  Use the format utility to resize the partitions to be consistent with the 
guidelines provided in this document (or site provided partition guidelines).  The following suggestions are 
provided for use with the format utility.   
 
• Initially, set all partition sizes to 0.  This will make it easier to determine the starting cylinder when 

resizing a partition.  Partitions should be contiguous, therefore, the starting cylinder for a given 
partition should be equal to the ending cylinder plus one (n+1) of the previous partition. 

• The following Partition ID Tags are recognized: root, swap, usr, var.  It is not necessary to specify a 
Partition ID Tag and you may use the default. 

• The following Partition Permission Flags are recognized: wm (for filesystems that may be written to 
and mounted) and wu (for filesystems that may be written to, but not mounted).  Most partitions will 
use the “wm” partition permission flag.  The swap partitions should use the “wu” partition permission 
flag. 

• Sizes may be specified in Blocks (b), cylinders (c), megabytes (m), or gigabytes (g).  Partition 
guidelines in this document are specified in megabytes.  Actual partition sizes may be slightly larger 
than specified as the format utility will round up to the next whole cylinder.  

• The /opt and/or /h partitions should be created last and will use all remaining space on each 
respective disk. Remaining space may be calculated in cylinders with the following formula.  Be sure 
to specify the size in cylinders if using this formula. 

Remaining disk space = ((Total # cylinders – 1) – (End cylinder # of last partition allocated) 
• A calculator is available by launching a new Command Tool window and issuing the xcalc 

command.   
• Remember to use the label command within format on each disk drive that is resized. 
• Please refer to the vendor provided documentation if you require further information. 
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B. Full Restore From Tape  
 
Select “Utilities/Command Tool” from the main menu to start a command tool window.  All commands 
will be executed from within the Command Tool window.  This example will create the filesystems 
necessary to perform a full restore of a system with two 18-GB disk drives using the partition guidelines 
specified in this document. 

 

 
 
 
Note:  All examples use the disk partition guidelines specified in this document.  Filesystem names and device
number will vary if using site supplied partition guidelines.

 
Create the filesystems on disk 0. 
 

newfs    /dev/rdsk/c0t0d0s0<cr> 
newfs –i 524288 –m 2  /dev/rdsk/c0t0d0s3<cr> 
newfs    /dev/rdsk/c0t0d0s4<cr> 
newfs    /dev/rdsk/c0t0d0s5<cr> 
 

Create the filesystems on disk 1. 
 
newfs    /dev/rdsk/c0t1d0s0<cr> 
newfs –i 524288 –m 2  /dev/rdsk/c0t1d0s3<cr> 
newfs    /dev/rdsk/c0t1d0s4<cr> 
newfs    /dev/rdsk/c0t1d0s5<cr> 
newfs    /dev/rdsk/c0t1d0s6<cr> 

 
The “-i” and “-m” flags are only applicable for the filesystems that will be used by Sybase. 
 
 
 
NOTE:  Unless otherwise noted, assume any large ‘0’ to be a zero, as compared to a capital ‘o’.  

Load the first full backup tape into the tape drive and rewind.  This example assumes that the tape device is 
0 and the root filesystem is the first volume on the tape, as is done in the previous section, Performing A 
Full System Backup to Tape. 
 

mt –f /dev/rmt/0 rewind<cr> 
 
Mount the root filesystem and restore from tape. The root filesystem must be restored before the other 
filesystems can be restored.  The /a directory is a convenient mount point to use that always exists when 
booting from CDROM. 

 
mount /dev/dsk/c0t0d0s0 /a<cr> 
cd /a<cr> 
ufsrestore –rf /dev/rmt/0n<cr> 

 
This will restore the root (“/”) partition to the hard drive. After the tape is done loading this partition, create 
new mount points for the other filesystems.  
 

mkdir /a/syb_devices_0<cr> 
mkdir /a/syb_devices_1<cr> 
mkdir /a/security1<cr> 
mkdir /a/security2<cr> 
mkdir /a/opt<cr> 
mkdir /a/h<cr> 

 
It is not necessary to create the /usr and /var mount points as they already exist. 
 
Mount the filesystems. 
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mount /dev/rdsk/c0t0d0s3 /a/syb_devices_0<cr> 
mount /dev/rdsk/c0t0d0s1 /a/security1<cr> 
mount /dev/rdsk/c0t0d0s5 /a/h<cr> 
mount /dev/rdsk/c0t1d0s0 /a/var<cr> 
mount /dev/rdsk/c0t1d0s3 /a/syb_devices_1<cr> 
mount /dev/rdsk/c0t1d0s4 /a/usr<cr> 
mount /dev/rdsk/c0t1d0s5 /a/security2<cr> 
mount /dev/rdsk/c0t1d0s6 /a/opt<cr> 
 
 
 

Note:  Sites that use a separate /var/audit filesystem should not mount or restore that filesystem until after the /var 
filesystem have been restored. 

 
Restore the filesystems. This example assumes the /, /usr, /var, /opt, /h filesystems were backed up 
in multiple records on a single tape.  The mt command with the no rewind option (n) is used to properly 
position the tape at the beginning of the appropriate volume. 
 

cd /a/usr<cr> 
ufsrestore rf /dev/rmt/0n<cr> 
cd /a/var<cr> 
ufsrestore rf /dev/rmt/0n<cr> 
cd /a/opt<cr> 
ufsrestore rf /dev/rmt/0n<cr> 
cd /a/h<cr> 
ufsrestore rf /dev/rmt/0n<cr> 
 
 
 

 

Note:  The restore order is dependent on the backup order if using a backup tape with multiple volumes.  Be certain 
the tape is positioned on the correct volume before restoring and that all necessary volumes are restored. 

It is now necessary to configure the vfstab file to mount the new filesystems on the appropriate mount 
points.  The following command will append filesystem and mount point information to the end of the 
vfstab file and will facilitate these modifications. 
 

df –k | grep \/a >> /a/etc/vfstab<cr> 
 
A sample vfstab file is provided below using the sample partition guidelines provided in this document. 
 
#device   device   mount  fs fsck mount mount  
#to mount  to fsck   point  type pass at boot options 
fd   -   /dev/fd  fd - no - 
/proc   -   /proc  proc - no - 
/dev/rdsk/c0t0d0s1 -   -  swap - no - 
/dev/rdsk/c0t1d0s1 -   -  swap - no - 
/dev/rdsk/c0t0d0s0 /dev/rdsk/c0t0d0s0 /  ufs 1 no - 
/dev/rdsk/c0t1d0s4 /dev/rdsk/c0t1d0s4 /usr  ufs 1 no - 
/dev/rdsk/c0t1d0s0 /dev/rdsk/c0t1d0s0 /var  ufs 1 no - 
/dev/rdsk/c0t0d0s5 /dev/rdsk/c0t0d0s5 /h  ufs 2 no - 
/dev/rdsk/c0t1d0s6 /dev/rdsk/c0t1d0s6 /opt  ufs 2 no - 
/dev/rdsk/c0t0d0s4 /dev/rdsk/c0t0d0s4 /security1 ufs 2 no - 
/dev/rdsk/c0t1d0s5 /dev/rdsk/c0t1d0s5 /security2 ufs 2 no - 
/dev/rdsk/c0t0d0s3 /dev/rdsk/c0t0d0s3 /syb_devices_0 ufs 2 no - 
/dev/rdsk/c0t1d0s3 /dev/rdsk/c0t0d0s3 /syb_devices_1 ufs 2 no - 
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4.) Sample Broadsword Gatekeeper Disk Partitions 
 
The disk partitioning provided here are samples for a Broadsword Gatekeeper.  Samples are only provided 
using UNIX filesystems for Sybase database devices.  These tables are to be used as guidelines only as 
actual disk partitions will be dependent on site architecture and requirements. 
 
 
 
 
 
 
 
 

Two 9 GB Drives  
Disk 0 Disk 1 

Device Name Size Comment Device Name Size Comment 
c0t0d0s0 / 576  c0t1d0s0 /var 1024  
c0t0d0s1 swap 1024  c0t1d0s1 swap  2048  
c0t0d0s2 overlap ALL  c0t1d0s2 overlap ALL  

c0t0d0s3 /syb_devices_0 2176 

Will include: 
<master> (128MB) 
<data_dev> (1024MB) 
<data_seg> (1024MB) 

c0t1d0s3 /syb_devices_1 896 

Will include: 
<procs> (128MB) 
<temp>  (256MB) 
<log>     (512MB) 

c0t0d0s4 /usr 766  c0t1d0s4 /security2 512 For AFDI C2 Audits 
c0t0d0s5 /security1 512 For AFDI C2 Audits c0t1d0s5 /h REST  
c0t0d0s6 /opt REST For AFDI Migration c0t1d0s6 
c0t0d0s7 NOT USED c0t1d0s7 NOT USED 

Two 18 GB Drives  
Disk 0 Disk 1 

Device Name Size Comment Device Name Size Comment 
c0t0d0s0 / 576  c0t1d0s0 /var 1024  
c0t0d0s1 swap 2048  c0t1d0s1 swap  2048  
c0t0d0s2 overlap ALL  c0t1d0s2 overlap ALL  

c0t0d0s3 /syb_devices_0 4222 

Will include: 
<master> (128MB) 
<data_dev> (2047MB) 
<data_seg> (2047MB) 

c0t1d0s3 /syb_devices_1 896 

Will include: 
<procs> (128MB) 
<temp>  (256MB) 
<log>     (512MB) 

c0t0d0s4 /usr 2048  c0t1d0s4 /security2 2048 For AFDI C2 Audits 
c0t0d0s5 /security1 2048 For AFDI C2 Audits c0t1d0s5 /h REST  
c0t0d0s6 /opt REST For AFDI Migration c0t1d0s6 
c0t0d0s7 NOTE USED c0t1d0s7 NOT USED 

One 9 GB Drive and One 18GB Drive  
Disk 0 (9GB) Disk 1 (18GB) 

Device Name Size Comment Device Name Size Comment 
c0t0d0s0 / 576  c0t1d0s0 /var 1024  
c0t0d0s1 swap 2048  c0t1d0s1 swap  2048  
c0t0d0s2 overlap ALL  c0t1d0s2 overlap ALL  

c0t0d0s3 /syb_devices_0 896 

Will include: 
<procs> (128MB) 
<temp>  (256MB) 
<log>      (512MB) 

c0t1d0s3 /syb_devices_1 4222 

Will include: 
<master>    (128MB) 
<data_dev>(2047MB) 
<data_seg> (2047MB) 

c0t0d0s4 /security1 1024 For AFDI C2 Audits c0t1d0s4 /usr 1024  
c0t0d0s5 /opt REST For AFDI Migration c0t1d0s5 /security2 1024 For AFDI C2 Audits 
c0t0d0s6 c0t1d0s6 /h Rest  
c0t0d0s7 NOT USED c0t1d0s7 NOT USED 

Note:  These partition tables are optimized for installing the Gatekeeper in an AFDI environment.  If installing the 
Gatekeeper in a CSE-SS environment instead of an AFDI  environment, then swap the location of the /opt and /h 
partitions.  For example, to install the Gatekeeper on a system with two 9 GB drives in the CSE-SS environment, the 
/h filesystem would be located on  c0t0d0s6 and the /opt filesystem would be located on c0t1d0s5.  Also, be sure to 
make /usr large enough (at least 1 GB) to support future operating system upgrades.  This may not be possible on 
small disk drive configurations. 
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Four 9 GB Drives  
Disk 0 Disk 1 

Device Name Size Comment Device Name Size Comment 
c0t0d0s0 / 576  c0t1d0s0 /var REST  
c0t0d0s1 swap 1024  c0t1d0s1 swap  1024  
c0t0d0s2 overlap ALL  c0t1d0s2 overlap ALL  

c0t0d0s3 /syb_devices_0 2048 Will include  
<data_dev> (2047MB) c0t1d0s3 /syb_devices_1 2048 Will include  

<data_seg>(2047MB) 
c0t0d0s4 /security1 REST For AFDI C2 Audits c0t1d0s4 /security2 2048 For AFDI C2 Audits 
c0t0d0s5 c0t1d0s5 
c0t0d0s6 c0t1d0s6 
c0t0d0s7 

NOT USED 
c0t1d0s7 

NOT USED 

Disk 2 Disk 3 
c0t0d0s0 /usr 2048  c0t1d0s0 /h REST  
c0t0d0s1 swap 1024  c0t1d0s1 swap  1024  
c0t0d0s2 overlap ALL  c0t1d0s2 overlap ALL  

c0t0d0s3 /syb_devices_2 128 Will include  
<master> (128MB) c0t1d0s3 /syb_devices_3 896 

Will include  
<procs>  (128MB) 
<temp>  (256MB) 
<log>      (512MB) 

c0t0d0s4 /opt REST For AFDI Migration c0t1d0s4 
c0t0d0s5 c0t1d0s5 
c0t0d0s6 c0t1d0s6 
c0t0d0s7 

NOT USED 
c0t1d0s7 

NOT USED 

Four 18 GB Drives  
Disk 0 Disk 1 

Device Name Size Comment Device Name Size Comment 
c0t0d0s0 / 2048  c0t1d0s0 /var REST  
c0t0d0s1 swap 2048  c0t1d0s1 swap  2048  
c0t0d0s2 overlap ALL  c0t1d0s2 overlap ALL  

c0t0d0s3 /syb_devices_0 4096 Will include  
<data_dev> (2047MB) c0t1d0s3 /syb_devices_1 896 

Will include  
<procs>  (128MB) 
<temp>  (256MB) 
<log>      (512MB) 

c0t0d0s4 /security1 REST For AFDI C2 Audits c0t1d0s4 /security2 2048 For AFDI C2 Audits 
c0t0d0s5 c0t1d0s5 
c0t0d0s6 c0t1d0s6 
c0t0d0s7 

NOT USED 
c0t1d0s7 

NOT USED 

Disk 2 Disk 3 
c0t0d0s0 /usr 2048  c0t1d0s0 /h REST  
c0t0d0s1 swap 2048  c0t1d0s1 swap  2048  
c0t0d0s2 overlap ALL  c0t1d0s2 overlap ALL  

c0t0d0s3 /syb_devices_2 128 Will include  
<master> (128MB) c0t1d0s3 /syb_devices_3 4096 

Will include  
<data_seg> 
(2047MB) 

c0t0d0s4 /opt REST For AFDI Migration c0t1d0s4 
c0t0d0s5 c0t1d0s5 
c0t0d0s6 c0t1d0s6 
c0t0d0s7 

NOT USED 
c0t1d0s7 

NOT USED 
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5.) Sample TTA Gatekeeper Disk Partitions 
 
The following tables provide examples for partitioning disks for a TTA Gatekeeper system hosted on a Sun 
Ultra 80 with a variety of disk configurations. These tables are recommended guidelines only. Actual disk 
partitions may be dependent on the site architecture. 
 

One 18 GB Drive  
Disk 0 

Device Name Size Comment 
c0t0d0s0 / 1536  
c0t0d0s1 swap 2048  
c0t0d0s2 overlap ALL  

c0t0d0s3 /syb_devices_0 3072 

Will include: 
<master> (128MB) 
<data_dev> (1024MB) 
<data_seg> (1024MB) 
<procs> (128MB) 
<temp>  (256MB) 
<log>     (512MB) 

c0t0d0s4 /usr 1024  
c0t0d0s5 /var 2048  
c0t0d0s6 /var/audit 4096  
c0t0d0s7 /opt REST  

 
 

Two 9 GB Drives  
Disk 0 Disk 1 

Device Name Size Comment Device Name Size Comment 
c0t0d0s0 / 1024  c0t1d0s0 /var 2048  
c0t0d0s1 swap 1024  c0t1d0s1 swap  2048  
c0t0d0s2 overlap ALL  c0t1d0s2 overlap ALL  

c0t0d0s3 /syb_devices_0 2176 

Will include: 
<master> (128MB) 
<data_dev> (1024MB) 
<data_seg> (1024MB) 

c0t1d0s3 /syb_devices_1 896 

Will include: 
<procs> (128MB) 
<temp>  (256MB) 
<log>     (512MB) 

c0t0d0s4 /usr 1024  c0t1d0s4 /var/audit REST  
c0t0d0s5 /home 512  c0t1d0s5 NOT USED 
c0t0d0s6 /opt REST  c0t1d0s6 NOT USED 
c0t0d0s7 NOT USED c0t1d0s7 NOT USED 
 
 

Two 18 GB Drives  
Disk 0 Disk 1 

Device Name Size Comment Device Name Size Comment 
c0t0d0s0 / 2048  c0t1d0s0 /var 4096  
c0t0d0s1 swap 2048  c0t1d0s1 swap  4096  
c0t0d0s2 overlap ALL  c0t1d0s2 overlap ALL  

c0t0d0s3 /syb_devices_0 4224 

Will include: 
<master> (128MB) 
<data_dev> (2048MB) 
<data_seg> (2048 MB) 

c0t1d0s3 /syb_devices_1 2176 

Will include: 
<procs> (128MB) 
<temp>  (1024 MB) 
<log>     (1024 MB) 

c0t0d0s4 /usr 2048  c0t1d0s4 /var/audit REST  
c0t0d0s5 /home 1024  c0t1d0s5 NOT USED 
c0t0d0s6 /opt REST  c0t1d0s6 NOT USED 
c0t0d0s7 NOT USED c0t1d0s7 NOT USED 
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6.) Installing the Solaris Operating System 
 
Shutdown the system to the boot (OK) prompt if it is not already there: 
 
• From either single or multi-user mode the system can be shutdown by logging in as root and issuing 

the following command: 
 

init 0<cr> 
 
• If you do not know the root password, the system may be halted with the following keystroke 

sequence: 
 

Press [STOP] and [A] keys simultaneously   
 
Power off the system and attach any peripherals you may need to perform the installation, such as a 
CDROM drive if one is not built into the system.  You may have to depress the on/off button for several 
seconds in order for it to take effect. 
 
Power the system back on and it should return to the boot prompt. If this system starts to boot up you will 
need to interrupt the boot sequence: 
 

Press [STOP] and [A] keys simultaneously 
 

(Only press this key combination on restart if you need to interrupt the boot sequence, and the system has 
just passed the memory count section of the boot process. If it has proceeded beyond the memory count for 
more than 15 seconds, allow the system to come up to normal multi-user level of operation, log in as an 
user with administrative privileges (cisso, cadmin, personal approved account, etc), change to root 

su -<cr> 
 
 and issue the command 

init 0<cr> 
) 
 
Once at the "OK" prompt, verify the system recognizes any new peripherals that were attached as well as 
the hard drives and CDROM drive since these will be essential for this portion of the installation. 
 

probe-scsi-all<cr> 
 
After a few moments, the devices and hard drives should be displayed to the screen. 
 
To ensure the best results from the system during the installation of the Solaris Operating System you may 
want to reset the system to its factory defaults.  Once this is completed, you can change a select few items 
to optimize it to your sites preferences.  Some items you may want to adjust include the boot-device, auto-
boot option, tpe-link-test option (not present on all systems), and the diag-device options.  To do this type 
the following commands: 
 

printenv 
set-defaults 
setenv boot-device disk0 
setenv auto-boot? False 
setenv tpe-link-test? false  

(This previous command may not be present on all systems, in which case the system will respond with a 
Command Not Found error.) 

setenv diag-device disk0 
These commands are discussed more below: 
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• printenv print a listing of the environment variables. 
• set-defaults resets the system to the factory defaults 
• boot-device specifies what device is used during a normal boot up.  Typically, the hard drive 

containing the root partition. 
• auto-boot? If set to true will automatically boot the system to normal runtime mode when power is 

applied to the system. 
• tpe-link-test? If set to false will turn off the Network Interface Card (NIC) to prevent the cable 

problem errors during the initial installation of the system.  It also prevents unwelcome users onto the 
system before the system if fully configured and secure. (Not present on all systems) 

• diag-device sets the default diagnostics device for troubleshooting purposes.  It's best to set this to 
match the boot-device for the time being. 
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A. Installing Solaris 2.6  

(Excluding on an Ultra 80 or other system with a processor speed higher than 400 MHz) 
 
Required Media: Solaris 2.6 CD, Software: 5/98 
 
Insert the CD into the CDROM drive and boot the system from the CDROM Drive.   
 

boot cdrom<cr> 
 
It may take a few minutes for the initial screen to appear. 
 
 Note:  Some systems will display a Graphical User Interface (GUI) to proceed with the installation.  Others will be in 

text format only.  For the remainder of the Solaris 2.6 Operating System Installation, both methods are included.  For 
example [CONTINUE] means to click on the button labeled CONTINUE.  Select F2 means press the [F2] key.  If 
you get the text version, use the arrow keys to maneuver within each window and the space bar to select items. 

 
 
 
 
 

 The first window to appear is the "Solaris Installation" window. Select F2 [Continue] 
 The "Program" window will appear. Select F2 [Continue] 
 The "Identify this System" window appears. Select F2 [Continue] 
 The "Host Name" window appears.  In the text box provided, enter the name of the workstation as it is 

to be known on the network (see your locally developed network cut-sheet).  Select F2  [Continue] 
 The "Network Connectivity" window appears.  Select Yes to indicate the system will be connected to 

the network, then Select F2   [Continue] 
 The "IP Address" window appears.  In the text box provided, enter the IP address of the workstation, 

then Select F2  [Continue] 
 The "Confirm Information" window appears.   Select F2  [Continue] if the information is correct.  To 

change information Select F4 [Change] 
 The "Name Service" window appears. Select “None” to indicate no NIS Service will be used at this 

time, then Select F2 [Continue] 
 The "Confirm Information" window appears.   Select F2  [Continue] if the information is correct.  To 

change information Select F4 [Change] 
 The "Subnets" window appears. Select [Yes] to indicate the system will be part of a subnet, then Select 

F2 [Continue] 
 The "Netmasks" window appears.  In the text box provided, enter the netmask the system will be 

using, then Select F2 [Continue] 
 The "Time Zone" window appears.  Select [Offset from GMT], then Select F2 [Continue].  (This set 

the time to GMT.  Set the time via your local commands policy. 
 The "Offset from GMT" window appears.  In the text box provided, enter [0], then Select F2  

[Continue].  If you have the GUI, then set the slide bar to [0] 
 The "Date and Time" window appears.  In the text boxes provided, enter the Zulu (GMT) date and 

time, then Select F2  [Continue] 
 The "Confirm Information" window appears.   Select F2  [Continue] if the information is correct.  To 

change information Select F4 [Change] 
 The "Solaris Install Software – Initial" window appears. Select F2 [Continue] 
 The "Upgrade System?" window appears. Select F4 [Initial] 
 The "Software" window appears.  

 For Broadsword Gatekeeper installations Select [Entire Distribution Plus OEM Support], then 
select F2 [Continue].  This should be the first item in the list. 

 For TTA Gatekeeper installations select [End User System Support], then select F2 [Continue]. 
 The "Disks" window appears. Select hard drives you will be using, then Select F2 [Continue] 
 The "Preserve Data" window appears. Select F2 [Continue] 
 The "Automatically Layout File Systems?" window appears. Select  F4 [Manual Layout] 
 The "File System and Disk Layout" window appears.  
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 The "Select Disk to Customize" window appears.  Select the first hard drive to layout, then Select F4 

[Customize] 
 
 

Note:   
• For Broadsword Gatekeeper installations allocate the file systems according to the tables found in the 

Sample Broadsword Gatekeeper Disk Partitions portion of this document. 
• For TTA Gatekeeper installations allocate the file systems according to the tables found in the Sample TTA 

Gatekeeper Disk Partitions portion of this document 
• The partition devices will vary from system to system.  It is very important that you document the device 

names and the partitions being assigned to them.  e.g c0t1d0s7 is /opt one system and c0t8d0s7 is /opt on 
another system.  This is critical during the installation of the Broadsword Software. 

• DO NOT modify the Overlap partition.  It must match the capacity of the drive you are partitioning. 
• DO NOT USE CAPS when typing. 
• Ensure you customize both drives. 

 
 
 
 
 
 
 
 
 
 
 
 

 When you are finished with the layout of both drives, Select F2 [OK] 
 The "File System and Disk Layout" window appears.   The scroll list shows the layouts for all defined 

tasks.   If an error is detected select F4 [Customize] to correct the data.  Otherwise Select F2 
[Continue] 

 The "Mount Remote File System" window appears. Select F2 [Continue] 
 The "Profile" window appears. The installation setup has been completed.  Verify that all information 

in this Profile scroll list is correct.   If an error is detected select F4 [Change], otherwise Select F2 
[Continue] 

 The "Begin Installing Solaris" window appears.   Select [Automatic Reboot], then Select F2  [Begin 
Installation]  

 
Note:  Load process takes an average of 45 minutes to an hour depending upon specific system architecture.  

 
When the Solaris 2.6 Operating System is finished installing the system will reboot and prompt you to enter 
a root password. 
 
When asked to enable power Management or not type N<cr> 
 
When asked to save this default answer type Y<cr> 
 
After reboot, login as root.   
 
The "Choose Desktop" window appears. Select CDE, then click Continue. 
 
If you are on a system that requires Raptor Graphics, proceed to Installing Raptor Graphics; otherwise 
proceed to the Installing Solaris Patches portion of this document. 
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B. Installing Solaris 2.6  

(Including Ultra 80 or other System with Processors higher than 400 MHz) 
 
 
Required Media: Operating Environment Installation CD, September 1999  

Solaris 2.6 CD, Software: 5/98 
 
Insert the Operating Environment Installation CD into the CDROM drive and boot the system from the 
CDROM Drive.   
 

boot cdrom<cr> 
 
This will begin the installation process.  It may take a few minutes for the initial screen to appear. 
 

 The "Language Selection" window appears.  Select Language: 1) English 
 Would you like to use this installer? Y<cr> 
 Do you want to format /dev/dsk/c0t0d0? Y<cr> 

 
  

 
 

 
 
 

Note:  This device may vary from system to system.  Ensure that you are familiar with your own system's device
names.  This item refers to the hard drive that will contain the root partition.
 Enter swap partition size:  2048<cr> 
 Is this OK? Y<cr> 

Note:  The installer program loads at this time.  This takes about 10 minutes. 

 The "Welcome" window appears.  Select NEXT 
 The "Host Name" window appears.  In the text box provided, enter the name of the workstation as it is 

to be known on the network (see your locally developed network cut-sheet). Select NEXT 
 The "Network Connectivity" window appears.  Select Yes to indicate the system will be connected to 

the network, then Select NEXT 
 The "IP Address" window appears.  In the text box provided, enter the IP address of the workstation, 

then Select NEXT 
 The "Netmasks" window appears.  In the text box provided, enter the netmask the system will be 

using, then Select NEXT 
 The "Name Service" window appears. Select “None” to indicate no NIS Service will be used at this 

time, then Select NEXT 
 The "Time Zone" window appears.  Select [Offset from GMT], then Select NEXT. (This set the time 

to GMT.  Set the time via your local commands policy. 
 The "Hours Offset" window appears.  Select 0, then Select NEXT 
 The "Date and Time" window appears.  In the text boxes provided, enter the Zulu (GMT) date and 

time, then Select NEXT  
 The "Root Password" window appears.  Enter the root password for the system, Select NEXT 
 The "Power Management window appears.  Select Off and Don’t ask, Select NEXT 
 The "Confirm Information" window appears.   Confirm the information is correct then Select NEXT.  

If the information is incorrect select Change and correct the information. 
 A "Welcome" window appears. Select NEXT 
 The "Select Solaris OS" window appears. Select Solaris OS: Solaris 2.6 Hardware: 5/98 then click 

NEXT. 
 The “Solaris OS Summary" window appears. Solaris OS Summary: verify information is correct then 

click NEXT. 
 Insert Solaris 2.5.1 Hardware: 11/97 CD-ROM when prompted. Insert CD: OK 
 The "Select Type of Installation" window appears. Select type of install:  Custom 
 The "System Locale Selection" window appears. System Locale Selection:  English US 
 The "Select Solaris Cluster Configuration" window appears.  
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 For Broadsword Gatekeeper installations select Solaris Cluster Configuration: Entire 

Distribution Plus OEM Support, then select F2 [Continue]. 
 For TTA Gatekeeper installations select Solaris Cluster Configuration: End User System 

Support, then select F2 [Continue]. 
 The "Laying Out File Systems" window appears. Layout file systems: move all available disks to 

selected disks then click NEXT. 
 The "Layout File Systems" window appears. Highlight disk to configure and select Modify. 

 
Note:   

• Allocate the file systems according to the tables found in the Sample Disk Partitions portion of this 
document. 

• The partition devices will vary from system to system.  It is very important that you document the device 
names and the partitions being assigned to them.  e.g.  c0t1d0s7 is /opt on one system and c0t8d0s7 is /opt 
on another system.  This is critical during the installation of the Broadsword Software. 

• DO NOT modify the overlap partition.  It must match the capacity of the drive you are partitioning. 
• DO NOT USE CAPS when typing. 
• Layout the last drive first.  If you layout your first drive first you will not be able to select your last drive.  

This is a known bug with the Solaris installer. 

 
 
 
 
 
 
 
 
 
 
 

 The "Confirm Information" window appears.   Confirm the information is correct then Select Install.  
If the information is incorrect select Change and correct the information. 

 Installation Summary: verify information then click EXIT. 
 The "Reboot" window appears. Select Reboot and Reboot Now. 
 When the Solaris 2.6 Operating System is finished installing the system will reboot and prompt you to 

enter a root password. 
 When asked to enable power Management or not type N. 
 When asked to save this default answer type Y. 
 After reboot login as root.   
 The "Choose Desktop" window appears. Select CDE, then click Continue. 

 
If you are on a system that requires Raptor Graphics, proceed to Installing Raptor Graphics; otherwise 
proceed to the Installing Solaris Patches portion of this document. 
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C. Installing  Solaris 7 
 
Required Media: Solaris 7 Software: 11/99 

 
 
 
Note:  For more detailed information on configuring Solaris 7 for use with AFDI refer to the AFDI UNIX ICG, 
Section 4.1.1. 

 
Insert the CD into the CDROM drive and boot the system from the CDROM Drive.   
 

boot cdrom<cr> 
 
This will begin the installation process.  It may take a few minutes for the initial screen to appear. 
 

 The "Language and Locale" window appears. In the Languages list box highlight English and in the 
Locales list box highlight USA (ASCII), then click Continue.  

 The "Solaris Installation Program" window appears. Click Continue 
 The "Identify this System" window appears. Click Continue 
 The "Host Name" window appears.  Enter the machine's hostname in the text box provided, then click 

Continue. 
 The "Network Connectivity" window appears. Select Yes, then click Continue 
 The "IP Address" window appears.  Enter the machine's IP Address in the text box provided, then click 

Continue 
 The "Confirm Information" window appears.  Verify the information, then click Continue.  If you see 

a problem, click Change to correct the errors. 
 The "Name Service" window appears. Select None, then click Continue. 
 The "Confirm Information" window appears.  Verify the information, then click Continue.  If you see 

a problem, click Change to correct the errors. 
 The "Subnets" window appears. Select Yes, then click Continue. 
 The "Netmask" window appears.  Enter the subnet mask for this system in the text box provided, then 

click Continue. 
 The "Time Zone" window appears. Select Offset from GMT, then click Set. 
 The "Offset from GMT" window appears. Select 0, then click Continue. 
 The "Date & Time" window appears.  Enter the proper date and time in the text boxes provided, then 

click Continue. 
 The "Confirm Information" window appears.  Verify the information, then click Continue.  If you see 

a problem, click Change to correct the errors. 
 The "Solaris Interactive Installation" window appears. Click on Initial 
 The "Solaris Interactive Installation" window appears. Click Continue. 
 The "Allocate Client Services?" window appears. Click Continue. 
 The "Select Languages" window appears. Click Continue. 
 The "Select Software" window appears. Select Entire Distribution Plus OEM Support, then click 

Continue. 
 The "Select Disks" window appears.  Highlight and add the hard drives you will be using, then click 

Continue. 
 The "Preserve Data" window appears. Click Continue 
 The "Automatically Layout File System" window appears. Click Manual Layout. 
 The "File System & Disk Layout" window appears. Click Customize.   
 The "Customize Disk" window appears.  Enter the appropriate information in the text boxes provided, 

then click OK. 
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Note:   
• Allocate the file systems according to the tables found in the Sample Disk Partitions portion of this 

document. 
• The partition devices will vary from system to system.  It is very important that you document the 

device names and the partitions being assigned to them.  e.g.  c0t1d0s7 is /opt on one system and 
c0t8d0s7 is /opt on another system.  This is critical during the installation of the Broadsword 
Software. 

• DO NOT modify the overlap partition.  It must match the capacity of the drive you are partitioning. 
• DO NOT USE CAPS when typing. 
• Do not name the partitions with in brackets (example: <master_mirror >), these are “RAW Partitions” 

and are used by Sybase and will be labeled later in the build procedure. Only assign the size of the 
partition at this time. 

• Ensure you customize both drives 
• Layout the last drive first.  If you layout your first drive first you will not be able to select your last 

drive.  This is a known bug with the Solaris installer. 

 
 

 The "File System & Disk Layout" window appears. Click Continue 
 The "Mount Remote File Systems" window appears. Click Continue 
 The "Profile" window appears. Click Begin Installation 
 The "Boot" window appears. Click Auto Reboot 

 
When the Solaris 7 Operating System is finished installing the system will reboot and prompt you to enter a 
root password. 
 
After the root password is set, you will be asked two questions: 
 

 Do you want this automatic power-saving shutdown? 
(If this system is used as a server, answer n) [y,n,?]   Type n 

 Do you want the system to ask about this again, when you next reboot? 
(This gives you the chance to try it before deciding whether to keep it.) [y,n,?]  Type n 

 
 The "Choose Desktop" window appears. Select CDE, then click Continue. 

 
After reboot login as root.   
 
If you are on a system that requires Raptor Graphics, proceed to Installing Raptor Graphics; otherwise 
proceed to the Installing Solaris Patches portion of this document. 
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D. Upgrading to Solaris 7 from Solaris 2.6 
 
Required Media: Solaris 7 Software: 11/99 
 
 
 
 
 
 

Note:  The example in this section will only upgrade the existing software distribution form Solaris 2.6 to Solaris 7. 
Also, this section does not address resizing of partitions.  Please ensure that partitions are properly sized before 
proceeding or refer to the appropriate section in this document to resize the partitions.  For more detailed information 
on configuring Solaris 7 for use with AFDI refer to the AFDI UNIX ICG, Section 4.1.1. 

Insert the CD into the CDROM drive and boot the system from the CDROM Drive.   
 

boot cdrom<cr> 
 
This will begin the installation process.  It may take a few minutes for the initial screen to appear. 
 

 The "Language and Locale" window appears. In the Languages list box highlight English and in the 
Locales list box highlight USA (ASCII), then click Continue.  

 The "Solaris Installation Program" window appears. Click Continue 
 The "Identify this System" window appears. Click Continue 
 The "Host Name" window appears.  Enter the machine's hostname in the text box provided, then click 

Continue. 
 The "Network Connectivity" window appears. Select Yes, then click Continue 
 The "IP Address" window appears.  Enter the machine's IP Address in the text box provided, then click 

Continue 
 The "Confirm Information" window appears.  Verify the information, then click Continue.  If you see 

a problem, click Change to correct the errors. 
 The "Name Service" window appears. Select None, then click Continue. 
 The "Confirm Information" window appears.  Verify the information, then click Continue.  If you see 

a problem, click Change to correct the errors. 
 The "Subnets" window appears. Select Yes, then click Continue. 
 The "Netmask" window appears.  Enter the subnet mask for this system in the text box provided, then 

click Continue. 
 The "Time Zone" window appears. Select Offset from GMT, then click Set. 
 The "Offset from GMT" window appears. Select 0, then click Continue. 
 The "Date & Time" window appears.  Enter the proper date and time in the text boxes provided, then 

click Continue. 
 The "Confirm Information" window appears.  Verify the information, then click Continue.  If you see 

a problem, click Change to correct the errors. 
 
 
 
 
 

Note:  Pay careful attention to the next step as it is very important.  Be certain to select the Upgrade option in  order 
to upgrade from Solaris 2.6 to Solaris 7.  This sample assumes that the current software distribution will only be 
updated and not modified. 

 
 The "Solaris Interactive Installation" window appears. Click on Upgrade. 
 The "Select Languages" window appears. Click Continue. 
 The “Analyzing System” window appears and exits after completion. 
 The “Customize Software” window appears.  Leave the “Select To Include Solaris 64 Bit Support” 

toggle enabled. Click Continue. 
 The "Profile" window appears. Verify the information in the profile window is correct.  Click Begin 

Upgrade. 
 The “Upgrading Solaris Software - Progress” window appears and exits after completion 
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After the Solaris 7 Operating System is finished installing, reboot the system by issuing the following 
command in the “Solaris Install Console”. 
 

reboot<cr> 
 
If you are on a system that requires Raptor Graphics, proceed to Installing Raptor Graphics; otherwise 
proceed to the Installing Solaris Patches portion of this document. 
 
E. Installing  Raptor Graphics 
 
Required media: Raptor GFX Open Windows for Solaris CD 
 

Note:  You must be user root to perform these steps (unless specified otherwise).  
 
Insert the CD into the CDROM drive.  You may need to eject it from the command line if it does not eject 
by pressing the button on the CDROM Drive.  To do this type eject cdrom from the command 
prompt. 
 
Once you have inserted the Raptor GFX Open Windows for Solaris CD into the CDROM Drive type the 
following command to begin the installation: 
 

pkgadd –d /cdrom/cdrom0<cr> 
 

 When prompted for which packages to add enter: all<cr> 
 Enter y to all other questions asked during this installation process. 
 When a message is displayed stating "Installation of TSIgfxdrv was successful", then prompted for 

which packages to add again, enter q<cr> 
 
Eject the CDROM from the command prompt. 
 

eject cdrom<cr> 
 
The installation of Raptor GFX Open Windows for Solaris is now complete. Proceed to the Installing 
Solaris Patches portion of this document. 
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7.) Installing Solaris Patches 
 
A. Installing the Solaris 2.6 Recommended and Y2K Patches  
 
Required – Either 1) the latest patch clusters from the any of the sites listed on page D-3, above 
      or 2) the June 15th, 2001 patch cluster set distributed to the Broadsword installation teams 
 

Note:  You must be user root to perform these steps (unless specified otherwise).  
 
The following patches are contained or superceded in these files and are recommended as a minimum 
requirement for Broadsword. 
 
105284-47 
105338-27 
105356-18 
105357-04 
105375-26 
105379-07 
105395-07 
105403-04 
105405-03 
105407-01 
105464-02 
105472-08 
105486-07 
105529-11 
105552-03 
105558-04 
105562-03 
105566-11 
105580-18 

105615-09 
105633-60 
105642-08 
105665-04 
105667-03 
105669-11 
105693-12 
105703-27 
105720-19 
105722-07 
105741-09 
105755-10 
105780-05 
105786-14 
105792-07 
105800-07 
105837-03 
105847-11 
105990-05 

106027-10 
106040-18 
106049-03 
106112-06 
106123-05 
106125-12 
106193-06 
106222-01 
106226-02 
106235-09 
106242-03 
106257-05 
106271-09 
106285-03 
106292-11 
106301-04 
106303-03 
106361-13 
106415-04 

106429-02 
106437-03 
106439-09 
106448-01 
106468-05 
106495-01 
106522-04 
106569-01 
106592-04 
106625-13 
106639-06 
106648-01 
106649-01 
106650-04 
106828-01 
106834-02 
106882-02 
107298-03 
107326-02 

107336-01 
107434-01 
107490-01 
107618-02 
107733-09 
107758-01 
107766-01 
107774-01 
107991-02 
108199-01 
108201-01 
107565-03 
108307-02 
108333-02 
108346-03 
108468-02 
108492-01 
108499-01 
108660-01 

108804-02 
108890-01 
108893-01 
108895-01 
109266-03 
109339-02 
109388-01 
109719-01 
110990-01 
111029-01 
111039-02 
111109-01 
111236-01 
111240-01 
111560-01 
111572-01 
111664-01 
111859-01 

 
Locate the files on the Broadsword server or on a network device that the Broadsword server has access to. 
For the rest of this, we’ll assume that the patches may be found on a CD inserted into the machine, and 
therefore accessible in /cdrom/cdrom0 . 
 
To install the Solaris 2.6 Recommended Patches, extract the patches from the CD to the /tmp directory.  To 
do this you would use a command similar to the example shown below: 
 
cd /tmp 
uncompress /cdrom/cdrom0/5.6_Recommended.tar.Z | tar xpvf - 
 
To begin installing the patch cluster type the following commands: 
 

cd /tmp/2.6_Recommended<cr> 
./install_cluster<cr> 

 
 When prompted, "Are you ready to continue with install?" type Y<cr>.   The Patches begin to install 

now.  This will take approximately 45 minutes. 
 
To install the Solaris 2.6 Y2K Patches, extract the patches from the CD to the /tmp directory.  To do this 
you would use a command similar to the example shown below: 
 
cd /tmp 
uncompress /cdrom/cdrom0/5.6_Recommended.tar.Z | tar pxvf - 
 
Extract the tar file and install the cluster: 
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cd /tmp/2.6_y2000_ALL<cr> 
./install_cluster<cr> 

 
 When prompted, "Are you ready to continue with install?" type Y<cr>.   The Patches begin to install 

now.  This will take approximately 30 minutes. 
 
Reboot the system from the command prompt. 
 

init 6<cr> 
 
After reboot login as root, then proceed to the appropriate section to load Solaris Utilities. 
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B. Installing the Solaris 7 Recommended Patches 
 
Required – Either 1) the latest patch cluster from any of the sites listed on page D-4, above 
      or 2) the June 15th, 2001 patch cluster set distributed to the Broadsword installation teams 
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Note:  You must be user root to perform these steps (unless specified otherwise).  Also, there are no Y2K patches for 
Solaris 7. 
he following patches are contained on or superceded in this patch cluster and are recommended as a 
inimum requirement for Broadsword. 

06300-12 
06327-11 
06541-18 
06725-02 
06793-07 
06924-08 
06925-08 
06934-04 
06938-04 
06942-17 
06950-16 
06952-03 
06960-01 
06978-12 
06980-17 
07018-03 
07022-08 
07038-02 
07081-40 

107115-09 
107148-10 
107171-09 
107180-28 
107200-14 
107259-02 
107285-06 
107332-02 
107337-02 
107359-02 
107374-02 
107403-02 
107441-03 
107443-14 
107451-06 
107454-05 
107456-01 
107458-13 
107460-10 

107469-08 
107475-03 
107477-04 
107544-03 
107587-01 
107636-08 
107650-08 
107654-08 
107656-07 
107684-02 
107702-09 
107709-16 
107792-02 
107794-01 
107834-03 
107841-03 
107885-08 
107887-10 
 

107893-15 
107972-02 
108029-03 
108162-05 
108219-01 
108221-01 
108263-08 
108301-02 
108327-02 
108343-04 
108374-05 
108376-33 
108451-05 
108482-02 
108484-01 
108551-03 
108574-03 
108662-01 
 

108721-04 
108748-02 
108750-02 
108754-01 
108756-01 
108758-01 
108760-01 
108762-01 
108764-01 
108798-02 
108815-02 
108838-03 
109203-03 
109253-04 
109404-01 
109409-04 
109709-01 
109744-01 
 

109949-01 
110070-01 
110281-02 
110646-03 
110869-01 
110881-01 
111093-01 
111113-01 
111238-01 
111242-01 
111350-01 
111578-02 
111590-02 
111600-01 
111666-01 
111980-01 
112106-01 
112300-01 

ocate the files on the Broadsword server or on a network device that the Broadsword server has access to. 
or the rest of this, we’ll assume that the patches may be found on a CD inserted into the machine, and 
erefore accessible in /cdrom/cdrom0 . 

o install the Solaris 7 Recommended Patches, extract the patches from the CD to the /tmp directory.  To 
o this you would use a command similar to the example shown below: 

cp /cdrom/cdrom0/7_Recommended.zip /tmp 

o extract the patches from the zip file, open the CDE, File Manager Application (Filing Cabinet Icon) and 
avigate to the /tmp directory.  Double click on the 7_Recommended.zip file.  The file unzips into the 
mp/7_Recommended directory. 

hange directories to the 7_Recommended directory and install the Solaris 7 Recommended Patch Cluster.  
o do this type: 

cd /tmp/7_Recommended 
./install_cluster 

 When prompted, "Are you ready to continue with install?" type Y<cr>.  The Patches begin to install 
now.  This will take approximately 20 - 45 minutes depending on system resources. When the patch 
cluster in finished installing, reboot the system.  To do this type: 

 init 6<cr> 

fter reboot login as root, then proceed to the appropriate section to load Solaris Utilities. 
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8.) Installing Solaris Utilities 
 
Required: Either Jumbo Travel Disc for Broadsword Installers CD, or software packages downloaded 
from the sites listed above on pages D3-D5. 
 
The following installation instructions are for utilities that are not required to run Broadsword. Note, 
however, that GZIP is needed to install either Netscape and/or Acrobat Reader. 
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Note:  You must be user root to perform these steps (unless specified otherwise).  This process assumes that the 
utilities will be loaded from the Jumbo Travel Disc for Broadsword Installers CD-ROM. If, instead, these packages
are being loaded from the download sites, the user should follow those sites’ directions for installing the software.
he instructions in this section will install the following utilities: 
 GZIP 1.2.4 
 LSOF 4.45 
 MPEG-Play 2.0 
 TCSH 6.09.00 
 TOP 3.5 
 Traceroute 
 UNZIP 5.4 
 Xanim 2.64 
 XV3.10 

sert the Jumbo Travel Disk CD into the CDROM drive.  You may need to eject from the command line if 
 doesn't eject by pressing the button on the CDROM Drive.  To do this type eject cdrom from the 
ommand prompt. 

reate the following directories and link if they do not already exist: 

mkdir /opt/local<cr> 
mkdir /opt/local/man<cr> 
mkdir /opt/local/lib<cr> 
mkdir /opt/local/bin<cr> 
ln –s /opt/local  /usr/local<cr> 

xtract the required Solaris utilities from the CD with the following commands: 

cd /cdrom/cdrom0<cr> 
./ExtractUtilities.sh<cr> 

o install the Utilities perform the following: 

cd /tmp/BroadswordUtilities<cr>  
./AddPackages.sh 

 
 You will be prompted, "The directory /var/sadm/f4s_pkgs does not exist.  Do you want to create it 

now? (n/y) [y]."   Enter:  Y<cr> 

he following two utilities must be loaded in order to run Broadsword more efficiently.  They are Adobe 
crobat Reader 4 and Netscape Communicator 4.7 or higher. Adobe, though not necessarily required, is 
seful in viewing AFRL documentation provided on the Broadsword 3.1 Documentation CDROM and 
etscape is required to interface with Broadsword. 
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A. Installing Adobe Acrobat Reader 4 
 
To install Adobe Acrobat Reader 4 on both Solaris 2.6 and Solaris 7 perform the following procedures: 
 

cd /tmp/BroadswordUtilities/TarFiles<cr>  
 

Extract (unzip) the .tar file then begin the installation process:    
 

tar pxvf sunsparc-rs-405.tar<cr> 
./SSOLRS.install/INSTALL<cr> 

 
 The "License Agreement Screen" will appear.  Page down using the <Spacebar> key until you see a 

message stating " Please type “accept” to accept the terms and conditions license agreement; Type 
“decline” to exit.  Type: accept<cr>   

 
 When prompted "Enter installation directory for Acrobat 4.0:" type:  

 
/opt/local/Acrobat4<cr> 

 
 You will receive a message stating that the /opt/local/Acrobat4 directory does not exit.  You will then 

be asked "Do you want to create it now?" type: Y<cr>.  Adobe Acrobat Reader install at this time and 
takes about one minute to complete. 

 
After Adobe Acrobat Read 4 is finished installing, link the Adobe Acrobat Reader 4 executable to the 
/usr/local/bin directory. 
 

ln –s /opt/local/Acrobat4/bin/acroread /usr/local/bin<cr> 
 
B. Installing Netscape Communicator 4.7X 
 
To install Netscape Communicator 4.7X on Solaris 2.5.1, Solaris 2.6 or Solaris 7 perform the following 
procedures: 
 

cd /tmp/BroadswordUtilities/TarFiles<cr>  
 
Extract (unzip) the .tar file.  This example is for Netscape 4.79 on a Solaris 2.5.1 system. 
 

tar pxvf communicator-v479-us.sparc-sun-solaris2.5.1.tar<cr> 
 
Begin the installation process. This example is for Netscape 4.79 on a Solaris 2.5.1 system. 
 

cd communicator-v479-sparc-sun-solaris2.5.1<cr> 
./ns-install<cr> 

 
 When prompted, "Directory containing the ‘gzip’ binary:", type /usr/local/bin<cr> 
 When prompted, "Location for Communicator software", type /opt/local/netscape<cr> 
 When prompted "/opt/local/netscape: No such directory.  Do you wish to create it? (y/n) [y]" type 
Y<cr>   

 
When Netscape Communicator 4.7X is finished installing, link the Netscape Communicator 4.7X 
executable to the /usr/local/bin directory. 
 

ln –s /opt/local/netscape/netscape /usr/local/bin<cr> 
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To use the Computer Based Training (CBT) from the Gatekeeper, it is necessary to load the Flash 
Shockwave Plugin.  Otherwise, the proceed to the next section. 
 
Required Media: Broadsword Computer Based Training (CBT)  v3.1 
 
Insert the CD into the CDROM drive.   
 
 Note:  You must be user root to perform each of the following steps. 

 
Once you have inserted the CBT CD-ROM, you need to extract the plugin form the CD-ROM to a 
temporary location.  To do this type the following commands. 
 
cd /tmp 
/usr/local/bin/gzip –dc /cdrom/cdrom0/plugins/solaris/plugin.tgz | tar pxvf - 
  

 
 
Note:  This command assumes the gzip utility in located in the /usr/local/bin directory.  If  not you need to modify 
these instructions to reflect the location of  the gzip utility on your system.

 
 
Verify the location of the actual plugin will be in the same location on the CD-ROM for the next version.  
Otherwise these instructions will not work. 
 
Next, view the readme file to ensure you have the latest instructions and documentation on this plugin. 
Follow any additional instructions that may apply.  To do this type the following commands: 
 
 cd flash_solaris 
 more README.TXT 
 
 
 
Note:  Follow any additional instructions that may apply. 

Verify that after extraction of the plugin the readme file is named as it appears above, capital letters and all.  
Otherwise these instructions will not work. 
 
Next, you need to copy the plugin to the Netscape Plugins directory.  To do this type the following 
commands: 
 

cp libflashplayer.so /opt/netscape/plugins 
 

 
 
Note:  These instructions assume you have loaded Netscape in the /opt/netscape directory.  If this is not true for your 
system, you need to modify these instructions to reflect the path to your Netscape Plugins directory. 

 
 
Verify that after extraction of the plugin the plugin file is named as it appears above.  Otherwise these 
instructions will not work. 
 
Next, change permissions on the Netscape directory so that to plugin can be used by any user.  To do this 
type the following commands: 
 

chown –R root:other /opt/netscape 
chmod –R 775 /opt/netscape 

 

 
 
Note:  These instructions assume you have loaded Netscape in the /opt/netscape directory.  If this is not true for your 
system, you need to modify these instructions to reflect the path to your Netscape directory.
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On some systems, in order to function properly, you may be required to add this plugin to the 
.netscape/plugins directory of individual users that will be launching Netscape on the actual Broadsword 
server.  Some examples would be for root, bswduser, cisso, etc.  If you intend to use the CBT in this 
manner, you may need to perform the following steps (using root as an example): 
 
 cd /.netscape 
 mkdir plugins 
 cp /opt/netscape/plugins/* /.netscape/plugins 
 chown –R root:other /.netscape 
 chmod –R 775 /.netscape 

 
 
 
Note:  These instructions assume you have loaded Netscape in the /opt/netscape directory.  If this is not true for your 
system, you need to modify these instructions to reflect the path to your Netscape Plugins directory. 
 
The following is an example of how to do this for the bswduser account. 
 
 cd /h/USERS/bswduser/.netscape 
 mkdir plugins 
 cp /opt/netscape/plugins/* /h/USERS/bswduser/.netscape/plugins 
 chown –R bswduser:bswd /h/USERS/bswduser/.netscape 
 chmod –R 775 /.netscape 

 
 
 
 
 
 
 
 

Note:   
- These instructions assume you have loaded Netscape in the /opt/netscape directory.  If this is not 

true for your system, you need to modify these instructions to reflect the path to your Netscape 
Plugins directory. 

 
- These instructions assume the bswduser account home directory is located at /h/USERS/bswduser.  If this is 

f d dif h i i fl h h
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9.) Miscellaneous Configuration 
 

Note:  You must be user root to perform these steps (unless specified otherwise).  
 
A. Automount Configuration 
 
Determine whether the site is using automount with the Network File System (NFS) to mount home 
directories, application directories, etc, and if it is necessary for the Broadsword system to access any of 
these filesystems.  If so, the automount maps (typically auto_master and auto_home) may be 
maintained locally (in /etc) or administered via NIS (or NIS+).   
 
• For locally maintained automount maps, arrange with the site SA to transfer (e.g. FTP) the appropriate 

maps (from a local workstation with the desired automount configuration) to the Broadsword system.  
Verify that the Broadsword system is configured to use local automount maps by examining the 
/etc/nsswitch.conf file for the following entry (or modify if necessary): 

 
automount: files 

 
• For centrally maintained automount maps (NIS/NIS+) the Broadsword system will be able to access 

these maps after it is properly configured into the site’s NIS/NIS+ domain.  Verify that the Broadsword 
system is configured to use NIS/NIS+ automount maps by examining the /etc/nsswitch.conf 
file for the following entry (or modify if necessary): 

 
automount: nis 

 
• For sites that are not using automount, edit the /etc/auto_home file and append the following 

line to end of the file: 
 

*  <tab>  `hostname`:/h/USERS/`hostname`/&  
 
Where `hostname` is the actual hostname of the system without the tick marks and the fields are 
tab delimited.  
 
Then edit the /etc/auto_master file and modify the following line: 

 
/home <tab> auto_home –nobrowse 

 
to read as follows: 

 
/home/`hostname` <tab> auto_home –nobrowse 

 
Where `hostname` is the actual hostname of the system without the tick marks and the fields are 
tab delimited. 
 

Start the automount daemon after performing the appropriate configuration for one of the above scenarios: 
 

automount<cr> 
 
This command may fail the first time it is invoked with a message similar to the following: 
 
`hostname` automount[##}: Mount of /h/USERS/bswdserv/bswdserv on /home/bswdser:  
No such file or directory 
automount:  /home/bswdserv:  Operation not applicable 
 
Re-issue the automount command if you receive an error message. 
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B. DNS Configuration 
 
Determine whether the site is using the Domain Name Service (DNS) for hostname resolution.  If so, it is 
usually advantageous to configure the Broadsword system to use DNS as well.  To configure the 
Broadsword system to use DNS, edit the /etc/nsswitch.conf file and modify the following line: 

  
hosts: files 

 
To read as follows: 
 

hosts: files dns 
 
It will also be necessary to edit the /etc/resolv.conf file.  This file will be empty if the system has 
not been previously configured to use DNS.  This file can be transferred (e.g. FTP) from a local 
workstation with the desired DNS configuration to the Broadsword system or it can be edited by hand.  In 
either case, it should contain a search line that includes your DNS domain name and a nameserver line that 
includes the IP Address of your commands DNS Server.  The following is provided as a sample: 
 

search     sitedomain.af.smil.mil 
nameserver 128.132.50.36 

 
Finally, edit the /etc/hosts file and modify the entry for the Broadsword server by adding the fully 
qualified domain name between the hostname and the loghost entries.  The following example would 
change from: 
 

128.132.50.36 bswdserv loghost 
 
to the following: 
 

128.132.50.36 bswdserv bswdserv.sitedomain.af.smil.mil loghost 
 
• Staging Note:  The Broadsword installation script assume a minimal DNS configuration (proper 

domain name and fully qualified domain name) to be in place. For staging purposes only (installs 
performed before the hardware is shipped to the site), modify the /etc/resolv.conf similar to 
the following: 

 
domain     staging.rl.af.mil 
nameserver 128.1.1.1 

 
Modify the /etc/hosts similar to the following: 
 

128.1.1.1 bswdserv bswdserv.staging.rl.af.mil loghost 
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C. Default Router Configuration 
 
Determine whether the site is using a default router (sometime referred to as a default gateway).  If so, it is 
may be advantageous to configure the Broadsword system to use a default router.  To configure the 
Broadsword system to use a default router, edit the /etc/defaultrouter file and enter the default 
router IP address.  This file will be empty if a default router has not been configured.  The following is 
provided as a sample: 
 

123.123.123.1 
 
This default route can be automatically activated by rebooting the system or manually activated by issuing 
the route command.  The following is provided as a sample: 
 

route add default 123.123.123.1 1<cr> 
 
Where the IP address will be the IP address of your default router.  You can verify that the route was added 
by issuing the following command: 
 

netstat –rn<cr> 
 
Destination       Gateway              Flags Ref Use   Interface 
-------------------- -------------------- ----- ----- ------ --------- 
default              123.123.123.1       UG     0  31732 

 
Observe that the output returned lists the IP address of your default router (under the Gateway column) as 
the default (under the Destination column). 
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D. Netmasks Configuration 
 
Determine whether the site is using IP subnetting.  If so, it will be necessary to configure the Broadsword 
system to use subnetting as well. The netmasks file contains network masks used  to  implement IP 
subnetting.  The netmasks file may be maintained locally (in /etc/inet) or administered via NIS (or 
NIS+).   
 
• For a locally maintained netmasks file, arrange with the site SA to transfer (e.g. FTP) the 

appropriate maps (from a local workstation with the desired netmasks configuration) to the 
Broadsword system.  Verify that the Broadsword system is configured to use local netmasks file by 
examining the /etc/nsswitch.conf file for the following entry (or modify if necessary): 

 
netmasks: files 

 
It will also be necessary to edit the /etc/inet/netmasks file.  This file will be empty if the system 
has not been previously configured to use subnetting.  This file can be transferred (e.g. FTP) from a local 
workstation with the desired netmasks configuration to the Broadsword system or it can be edited by hand.  
In either case, it should contain an entry that includes your network number and netmask.  The following is 
provided as a sample: 
 

123.123.0.0 255.255.255.0 
 
• For centrally maintained netmasks file (NIS/NIS+), the Broadsword system will be able to access 

this map after it is properly configured into the site’s NIS/NIS+ domain.  Verify that the Broadsword 
system is configured to use NIS/NIS+ netmasks maps by examining the /etc/nsswitch.conf file 
for the following entry (or modify if necessary): 

 
netmasks: nis 

 
Finally, reboot the server in order for these changes to take effect: 
 

init 6<cr> 
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10.) Sybase Adaptive Server 11.5.1 or 11.9.2 Installation Instructions 
 
You will be using the Sybase Adaptive Server 11.5.1 or 11.9.2 CDROM for this installation. 
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Note:  You must be user root to perform these steps (unless specified otherwise).  For existing Broadsword
Gatekeepers that will continue to use Sybase 11.5.1, this section should be skipped completely. 
or existing Broadsword Gatekeepers running Sybase 11.5.1 that will be upgraded to Sybase 11.9.2, 
name the Sybase directory and continue with the instructions provided in this section. 

mv /opt/SYBASE /opt/SYBASE_11.5.1 

or new Broadsword Gatekeepers you must create a Sybase account (e.g. sybase) with primary group sys 
rough the Sun admintool before loading Sybase Adaptive Server 11.5.1 (or 11.9.2) and Broadsword 3.1. 
o create this account using admintool, initialize admintool as follows: 

 
admintool& 

 
ote that, if this system already has CSE or AFDI installed those tools should be used in place of the 

dmintool. Please see a local administrator for assistance with this if necessary. 

he following parameters are provided as samples and assume that /opt/SYBASE is the directory where 
ybase will be installed. Actual values should be consistent with site configuration and security policy. 

Note: For Broadsword Gatekeepers that will be co-hosted with another application, be sure to select a 
descriptive Sybase directory name (e.g. /opt/SYBASE_BSWD) and user name (e.g. sybbswd ) that does 
not conflict with any existing Sybase directories or users. 

 The “Admintool: Users” window appears.  From the Edit menu select Add. 
 The “Admintool: Add User” window appears.  Fill in the information as detailed below. 

 User Name:  sybase 
 User ID:  1001 
 Primary Group: 3 

(verify that this gid corresponds to group sys in the /etc/group file. 3 is 
 standard, but your system may have been modified) 

 Comment:  Sybase Administrator Account. 
 Login Shell:   C 
 Password:  Normal Password  

(Do not forget to assign a password consistent with site policy) 
 Password Aging: Min Change:  0 

Max Change:  90 
Warning:  14 

 Create Home Dir: Select check mark 
 Path :   /opt/SYBASE 
Note:  Unix is case sensitive.  That means uppercase characters must be typed in uppercase and lowercase characters 
must be typed in lowercase.  It does make a difference.
 Once you have entered all the appropriate information click OK. 
 The “Admintool: Users” window appears.  From the File menu select Exit. 

                                                                                                                               D-41 



Broadsword-3.1-SYSIMG-20 Sept 02 
FINAL 

 
After creating the Sybase account, it is necessary to ensure the appropriate permissions for Sybase exist in 
the installation directory.  To set these permissions type the following commands at the command prompt. 
 

# chown –R sybase:sys /opt/SYBASE 
# chmod –R 755 /opt/SYBASE 

 
You will also need to ensure the appropriate permission for Sybase exist for those UNIX filesystems that 
will be used by the Sybase Data and Backup Servers and Broadsword applications.  The example below 
assumes these partitions are based on the recommended earlier in this document.  To set these permissions 
type the following commands at the command prompt: 
 
  # chown –R sybase:sys /syb_devices_0 
  # chown –R sybase:sys /syb_devices_1 
  # chmod –R 755 /syb_devices_0 
  # chmod –R 755 /syb_devices_1 
 
The following commands will be used in addition if this is a four hard drive configuration based on the 
recommended partitions earlier in this document. 
 
  # chown –R sybase:sys /syb_devices_2 
  # chown –R sybase:sys /syb_devices_3 
  # chmod –R 755 /syb_devices_2 
  # chmod –R 755 /syb_devices_3 
 
Next, insert the Sybase Adaptive Server 11.5.1 CDROM from the Installer Set into the CDROM drive and 
type the following commands to begin the Sybase installation. 
 

# cd /cdrom/cdrom0 
# ./sybsetup 

 
 The "Sybase Menu" window appears. In the Sybase Directory text box type /opt/SYBASE then 

click on Unload Sybase Products from CDROM or Tape 
 The "Installation Destination" window appears.   Click the Checkmark icon to continue. 
 The "Installation Source" window appears.  In the text box provided type sybimage then click the 

Checkmark icon. 
 The "Product Selection" window appears. From the list, highlight 11.5.1 Adaptive Server Enterprise 

(or 11.9.2 Adaptive Server Enterprise) then click the Checkmark icon to continue. 
 The "Install Products?" window appears. Click the Checkmark icon to continue. 

 
 Note:  Sybase installs at this time.  This takes about 3 minutes to complete. 
 

 The "Install sybsetup?" window appears. Click Yes to install additional application. 
 

Note:  Sybase installs at this time.  This takes about 1 minute to complete.  
 

 The "Success" window appears. Click on OK. 
 The “Installation Complete” window appears.  Click Exit. 
 The “Exit?” window appears. Click Exit. 

 
Again, you want to ensure that Sybase has the proper permissions for the installation of Broadsword 3.1. 
To set these permissions, type the following commands at the command prompt. 
 

# chown –R sybase:sys /opt/SYBASE 
# chmod –R 755 /opt/SYBASE 

 
The last step is to reboot the server.  
 

# init 6 
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After system reboot, login as root.  If you intend to load CSE-SS then proceed to Installing CSE-SS.  If 
you are installing AFDI, proceed to Installing AFDI.  If you do not intend to load either proceed to the 
System Installation Guide for Broadsword Gatekeeper Version 3.1. 
 
11.) Installing CSE-SS 
 
 
A. Installing CSE-SS for Solaris 2.6 and Solaris 7 
 
Media required: CSE-SS Version 1.4.2.1 for Solaris 2.6/2.7 CD 
 

Note:  You must be user root to perform these steps (unless specified otherwise).  
 
The Basic Security Module (BSM) must be enabled prior to the installation of CSE-SS. Activate BSM as 
follows: 
 

# init 1<cr> 
# /etc/security/bsmconv<cr> 
 

When asked "Continue with Conversion?" type Y<cr> 
 
 
 
 
 
 
 
 
 
 

Note:  BSM disables the Volume Management daemon (vold) and you will be unable to access the CDROM drive.  
You must manually invoke the vold daemon prior to the CSE-SS install in order to perform the CSE-SS installation.  
The Volume Manager can be invoked with the following command: 
 
 # /usr/sbin/vold & <cr> 
 
Alternatively, Volume Management may be configured to start during boot by typing the following commands: 
 
 # cd /etc/rc2.d <cr> 
 
 # ln –s ../init.d/volmgt S74volmgt <cr>  

 
BSM is now enabled on the system and it should be rebooted 
 

# init 6<cr> 
 
Before loading CSE-SS 1.4.2.1 and Broadsword 3.1, you must create a bswd group of 600 through the Sun 
admintool.  To create this group, invoke admintool: 

 
# admintool&<cr> 

 
 The “Admintool: Users” window appears.  From the Browse menu select Groups. 
 The “Admintool: Groups” window appears.  From the Edit menu select Add. 
 The “Admintool: Add Group” window appears.  Fill in the information as detailed below. 

 
 Group Name: bswd 
 Group ID:  600 
 Members List: “Leave blank” 

 
 Once you have entered the appropriate information click OK. 
 The “Admintool: Users” window appears.  From the File menu select Exit. 

 
Create the following home directory to be used by Broadsword accounts: 
 

# mkdir /export/home/`hostname`<cr> 
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Where `hostname` is the actual hostname of the server. 
 
• For the Solaris 2.6 insert the CSE-SS Version 1.4.2.1 for Solaris 2.6/2.7 CD and type the following: 
 

# cd /cdrom/cdrom0/1_4_2/2_6<cr> 
 
• For the Solaris 7.0 insert the CSE-SS Version 1.4.2.1 for Solaris 2.6/2.7 CD and type the following: 
 

# cd /cdrom/cdrom0/1_4_2/2_7<cr> 
 
Begin the installation process: 
 

 # ./install.cse<cr> 
 

 The "CDROM Directory" window appears. Click OK to continue. 
 The "CSE-SS Version 1.4.2 Installation" window appears.  Click the following items: 

 
 Base Software 
 Print Facility 
 Security Profile Inspector (SPI 3.2.2) 
 SPI Documentation 

 
 Once you have selected these four items click Install.   

 
Note:  The CSE-SS software installs at this time and takes about 5 minutes to complete.  

 
 The "CSE Installation Successful" window appears. Click OK 
 A "Dialog Box" appears stating "Install data copied". Click OK 
 A "Dialog Box" appears stating "Log file created". Click OK 
 The "CSE-SS V1.4.2 Installation” window appears. Click Setup 
 A "Text Box" appears. Click OK 
 A "Dialog Box" appears asking to Abort or Continue. Click Continue 
 The "CSE-SS V1.4.2 Setup" window appears. Click on the Environment icon 
 The "CSE-SS V1.4.2 Setup – Environment" window appears. No changes are required here. 
 Click on the XDISPLAY Manager (XDM)  icon 
 The "CSE-SS V1.4.2 Setup – XDISPLAY Manager (XDM)" window appears.  There should be no 

changes required here. Click on the Network Services icon 
 The "CSE-SS V1.4.2 Setup – Network Services" window appears. In the section labeled 

"Administration Type" click on Server. 
 In the section labeled "NTP Type" click on Server.  Click on the Print Banners icon 
 The "CSE-SS V1.4.2 Setup – Print Banners" window appears.  In the text boxes provided, fill out the 

appropriate information in the items marked: 
 

 Service Branch 
 Organization 
 Location 

 
 Click on the Security Labels icon 
 The "CSE-SS V1.4.2 Setup – Security Labels" window appears. In the text box marked 

"Classifications", enter a classification level that is allowed to be processed on the system, then click 
on the "Add Classification" button. 

 
Note:  Repeat this step until all permitted classifications are entered for the system.  

 
 Enter the appropriate information in the text boxes labeled: 
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 System High Label 
 System High Short Label 

 
 Click on the Centralized Log/Audit Support Subsystem icon 
 The "CSE-SS V1.4.2 – Centralized Log/Audit Support Subsystem" window appears. 
 In the text box labeled "Server Name?" enter the hostname of the server. Click on the DNS Resolver 

icon 
 The "CSE-SS V1.4.2 Setup – DNS Resolver" window appears.  For "Type" select NONE. Click on the 

Verify CSE Software Configuration icon 
 

  
 

 
 
 

 

 

 

 

 

 

Note:  Settings are validated at this time.  Make any necessary changes, then continue.
 Click on the Return to Main Menu icon.   
 The "CSE-SS V1.4.2 Setup" window appears. 
 From the "File" menu, select "Save & Execute" 

Note:  Configuration changes are implemented at this time. 

 Click "Close" 
 The "CSE-SS V1.4.2 Setup- Log" window appears.  Click "Close" 
 The "CSE V1.4.2 Setup" window appears. From the File menu, select Exit & Run Administration 
 The "Exit CSE-SS V1.4.2 Setup" window appears. Click Yes 
 The "CSE-SS V1.4.2 Administration" window appears. Click on the User Account icon 
 The " CSE-SS V1.4.2 Administration – User Account" window appears. Click cisso, then enter the 

appropriate information in the following text boxes: 

 Password 
 Verify Password 
 Path to Home Directory 
 Shell = /bin/csh 

 Then click yes to create user account.  When the dialog box stating User Account Created appears, 
click OK. 

 Click cadmin, then enter the appropriate information in the following text boxes: 

 Password 
 Verify Password 
 Path to Home Directory 
 Shell = /bin/csh 

 Then click yes to create user account.  When the dialog box stating User Account Created appears, 
click OK. 

 Click coper, then enter the appropriate information in the following text boxes: 

 Password 
 Verify Password 
 Path to Home Directory 
 Shell = /bin/csh 

 Then click yes to create user account.  When the dialog box stating User Account Created appears, 
click OK. 

 Click on the TFM icon. 
 The CSE-SS V1.4.2 Administration – Role (TFM Group)" window appears. Click isso.   
 Click Yes to create role account now.   When the dialog box stating Role isso created, click OK. 
 Click admin.   
 Click Yes to create role account now.   When the dialog box stating Role admin created, click OK. 
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 Click oper.   
 Click Yes to create role account now.   When the dialog box stating Role oper created, click OK. 
 Click on the TFM Privilege icon. 
 The "CSE-SS V1.4.2 Administration – TFM Privilege" window appears. Click Yes. 
 The "Select A Role" window appears. Highlight isso, then click OK. 
 The "CSE-SS V1.4.2 Administration – TFM Privilege" window appears.  Click isso 
 Click Yes.   
 When the "Role ISSO Updated" window appears, click OK. 
 The "Select A Role" window appears. Highlight admin, then click OK. 
 The "CSE-SS V1.4.2 Administration – TFM Privilege" window appears.  Click admin 
 Click Yes.   
 When the "Role admin Updated" window appears, click OK. 
 The "Select A Role" window appears. Highlight oper, then click OK. 
 The "CSE-SS V1.4.2 Administration – TFM Privilege" window appears.  Click oper 
 Click Yes.   
 When the "Role oper Updated" window appears, click OK. 
 The "Select A Role" window appears.  Click Cancel. 
 The "CSE-SS V1.4.2 Administration – TFM Privilege" window appears. Click on the Network Port 

icon.   
 The "CSE-SS V1.4.2 Administration – Network Port" window appears. Click on the Return to Main 

Menu icon. 
 The "CSE-SS V1.4.2 Administration" window appears. From the "File" menu, select "Exit & Run 

Setup". 
 A "Text Box" window appears. Click Yes. 
 A "Text Box" window appears. Click OK. 
 A message appears asking to Abort or Continue. Click Continue 
 The "CSE-SS V1.4.2 Setup" window appears. From the "File" menu, select "Exit". 
 The "Exit CSE-SS V1.4.2 Setup" dialog box appears. Click Yes. 
 A "Text Box" window appears. In the text box labeled "Map Name", type the systems hostname 

followed by _local. 
 
 IE.  `hostname`_local 
 

Note:  Where `hostname` is the actual hostname of the server.  Be sure not to include the ` marks.  
 

 Next to "Map Type" click "Local", then click "OK" 
 The "CSE-SS V1.4.2 Map Administration" window appears. Click on the Distribution icon 
 The "CSE-SS V1.4.2 Map Administration – Distribution" window appears. Select all databases under 

Target Databases. 
 For "Target OS", select Solaris, then click on the Defaults icon. 
 The "CSE-SS V1.4.2 Map Administration – Defaults" window appears.  For each of the text boxes 

provided enter the appropriate data as follows: 
 

 UserID   min  11000 max  20000 
 Password Aging:  min  0  max  90  warning  14 
 Home Directory Parent /export/home/`hostname` 
 Login Directory Parent /export/home/`hostname` 
 Shell   /bin/csh 

 
 Change the following items to your command's information: 

 
 Office 
 Office Phone 
 Organization 

 

                                                                                                                               D-46 



Broadsword-3.1-SYSIMG-20 Sept 02 
FINAL 

 
 Click on the Initial Population icon. 
 The "CSE-SS V1.4.2 Map Administration – Initial Population" window appears. Click on local for all 

entries, then click on the Return to Main Menu icon. 
 The "CSE-SS V1.4.2 Map Administration" window appears. From the Map menu, select Create. 

 
 
  
 
 

 
 
 

 
 
 
 

   
Note:  CSE-SS populates at this time.  Defaults can be changed after installing CSE-SS by modifying the
/opt/cse/etc/maps/mapdir/users file. 
From the Map menu, select Close. 
From the Map menu, select Exit 
Select Yes. 

 
Note:  No reboot is required after loading this portion of CSE-SS.  Do not eject the CD-ROM at this time.  You will
be using it to install some CSE-SS Patches.
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B. Upgrading CSE-SS from Solaris 2.6 to Solaris 7 
 
Media required: CSE-SS Version 1.4.2.1 for Solaris 2.6/2.7 CD 
 

Note:  You must be user root to perform these steps (unless specified otherwise).  Login with any user account that 
has the appropriate privileges to run the User Administration Tool and access to a shell window.  Open a new shell 
window and su to root

 
 
 
 
Insert the CSE-SS Version 1.4.2.1 for Solaris 2.6/2.7 CD and type the following: 
 

# cd /cdrom/cdrom0/1_4_2/2_7<cr> 
 
Begin the upgrade process: 
 

# ./install.cse<cr> 
 

 The "CDROM Directory" window appears. Click OK to continue. 
 The "CSE-SS Version 1.4.2 Installation" window appears.  Attempt to click Base Software. 

 
Note:  Pay careful attention to the next step as it is very important.  Be certain to select the Upgrade option in order to 
upgrade CSE-SS 1.4.2.1 from Solaris 2.6 to Solaris 7.  This sample only updates the CSE-SS binaries and does not 
modify the CSE-SS configuration. 

 
 
 
 

 The "/opt/cse already exists!" window appears.  Click Upgrade. 
 The "CSE-SS Version 1.4.2 Installation" window appears.  Note the Install button has changed to 

Upgrade.  Click the following items: 
 

 Base Software 
 Print Facility 
 Security Profile Inspector (SPI 3.2.2) 
 SPI Documentation 

 
 Once you have selected these four items click Upgrade.   
 The “Base Software: Upgrading in /opt” window appears and exits when complete. 

 
Note:  The CSE-SS software installs at this time and takes about 5 minutes to complete.  

 
 The "CSE Installation Successful" window appears. Click OK 
 A "Dialog Box" appears stating "Install data copied". Click OK 
 A "Dialog Box" appears stating "Log file created". Click OK 
 The "CSE-SS V1.4.2 Installation” window appears. Click Setup 
 A text box appears stating “Since the Base Software was upgraded, Setup only need to be Verified and 

Save & Executed at this time”. Click OK. 
 An untitled text box appears verifying configuration of NIS, system software packages, security, 

auditing. Click OK. 
 A "Dialog Box" appears asking to Abort or Continue. Click Continue. 
 The "CSE V1.4.2 Setup" window appears. From the File menu, select Exit. 
 The "Exit CSE V1.4.2 Setup" window appears. Click Yes. 

 
Now is an opportune time to update any user home directories that may have changed if the home directory 
filesystem(s) were modified during the operating system upgrade.  Modification and update of user home 
directories should be accomplished through the CSE-SS User Maintenance Tool (from the ISSO palette) 
 

Note:  No reboot is required after loading this portion of CSE-SS.  Do not eject the CD-ROM at this time.  You will 
be using it to install some CSE-SS Patches.
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12.) CSE-SS Patches Installation Instructions for Solaris 2.6, and Solaris 7 
 
Required Media: CSE-SS Version 1.4.2.1 for Solaris 2.6/2.7 CD 
 

Note:  You must be user root to perform these steps (unless specified otherwise).  
 
For Solaris 2.5.1 insert the CDROM entitled CSE-SS Version 1.4.0.3 for Solaris 2.5.1: 
 

# cd /cdrom/cdrom0/patch<cr> 
 
For the Solaris 2.6/7.0 insert the CDROM entitled CSE-SS Version 1.4.2.1 for Solaris 2.6/2.7: 
 

# cd /cdrom/cdrom0/patch<cr> 
 
Begin the patch installation process: 
 

# ./patchcse –if<cr> 
 
During this installation process you will be prompted several times to enter information. 
 

 You will then be asked, "Do you wish to use these values?" type Y<cr> 
 Next you will be asked, "Are these values OK?" type Y<cr> 

 
• For Solaris 2.6 or Solaris 7 systems with CSE-SS 1.4.2 the CSE-SS installation is now complete.  

When your command prompt appears again, remove the CDROM and reboot your server: 
 

# init 6<cr> 
 
Once the server has rebooted, login as cisso and begin the Broadsword installation. 
 
• For Solaris 2.5.1 system with CSE-SS 1.4.0.2 continue with these procedures. 
 

 You will then be asked, "Do you want to add password aging to root?" type N<cr> 
 

When your command prompt returns: 
 

# cd /<cr> 
# eject cdrom<cr> 

 
Insert the CSE-SS Version 1.4.0.3 for Solaris 2.5.1 cdrom dated June 1999: 

 
# cd /cdrom/cdrom0<cr> 
# ./patchcse –if<cr> 

 
During this installation process you will be prompted several times to enter information.  By pressing <cr> 
you will accept all of the default settings. 

 
 You will then be asked, "Do you wish to use these values?" type Y<cr> 
 Next you will be asked, "Are these values OK?" type Y<cr> 
 You will then be asked, "Do you want to add password aging to root?" type N<cr> 

 
When your command prompt appears again, remove the CDROM and reboot your server: 
 

# init 6<cr>  
 

Once the server has rebooted, login as cisso and begin the Broadsword installation. 
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13.) AFDI 1.1 for Solaris 7 Installation Instructions 

 
A. Installing DII COE 4.2.0.0 
 
Required Media: AFDI 1.1.0.1, for Solaris 7, 23 May 2001 
 
For additional guidelines on installing DII COE 4.2.0.0, please review the AFDI UNIX Installation and 
Configuration Guide, Section 4.2, Installing DII COE 4.2.0.0, page 46, located on the AFDI 1.1 CDROM. 
 

Note:  You must be user root to perform these steps (unless specified otherwise).  
 
Before loading CSE-SS 1.4.2.1 and Broadsword 3.1, you must create a bswd group of 600 through the Sun 
admintool.  To create this group, invoke admintool: 

 
# admintool&<cr> 

 
 The “Admintool: Users” window appears.  From the Browse menu select Groups. 
 The “Admintool: Groups” window appears.  From the Edit menu select Add. 
 The “Admintool: Add Group” window appears.  Fill in the information as detailed below. 

 
 Group Name: bswd 
 Group ID:  600 
 Members List: “Leave blank” 

 
 Once you have entered the appropriate information click OK. 
 The “Admintool: Users” window appears.  From the File menu select Exit. 

 
The following significant changes are made to the system once DII COE is installed: 
 

Root login to the console will be disabled. • 
• Services such as finger, ftp, name, rexec, rlogin, rpc.cmsd, rsh, telnet, and uucp will be disabled. 
 
Insert the AFDI 1.1 for Solaris 7 CDROM.  If autostart doesn’t spawn the CDROM File Manager you may 
have to start the volume manager.  To start the volume manager type the following command: 
 
  # /etc/init.d/volmgt start 
 
Once the CDROM File Manager window appears, you know the CDROM is mounted and ready for use.  
To begin the DII COE installation type the following commands at the command prompt: 
 
  # cd /cdrom/cdrom0 
  # ./inst.dii 
 
The “Installing DII COE Kernel 4.2.0.0” screen appears informing you the log file for this installation will 
be /var/adm/COE4200_install.log.<date>.<time> 
 

  
 
 
 

Note:  <date> equates to the current date as in 10022001 (10 Feb, 2001) 
<time> equates to the time as in 142359.  (14:23:59)  
e.g. /var/adm/COE4200_install.log.10022001.142359 
 When prompted, “Does this network have a default router?” press [Return] to accept the default of 
yes. 

 When prompted, “Enter the IP Address of you Default Router, then press [Return]:”, Enter the IP 
address of the default router and then press [Return]. 

 The system will have you verify the IP address you’ve entered for the default router, then prompt you, 
“Press [y] for yes or [n] for no, then press [Return]”, press [Return] to accept the default of yes. 
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 When prompted, “What media type is the kernel on?   Select:”, type 3 for CDROM, then press 

[Return]. 
 
You will then receive the following message: 
 
 Begin Installing COE 4.2.0.0 
 
At this point DII COE begins to install.  After about 3 – 5 minutes the following prompt will appear: 
 
 Enter a password for sysadmin 
 New password: 
 

 Enter an appropriate password, then press [Return]. 
 You will then be prompted, “Re-enter new password:”, re-enter the password you used, then press 

[Return]. 
 
After setting the sysadmin password, the following prompt will appear: 
 
 Enter a password for secman 
 New password: 
 

 Enter an appropriate password, then press [Return]. 
 You will then be prompted, “Re-enter new password:”, re-enter the password you used, then press 

[Return]. 
 
Once you have entered and verified the passwords for sysadmin and secman, the following message 
appears: 
 
 “Sysadmin and secman passwords have been entered.” 
 

 After a few moments you will be prompted, “Would you like to enable APM Authentication?”. 
 “Press [y] for yes or [n] for no, then press [Return]”, press [Return] to accept the default of yes. 

 You will then be prompted, “Please enter the master key (must be at least six characters):”.  Enter an 
appropriate password then press [Return]. 

 
Note:  This APM master authentication key must be used when installing segments via Segment Installer or 
performing transactions using APM.  The master key is visible while being typed during this procedure only. 

 
 

 After a few moments you will then be prompted, “Press Enter to reboot and finish installation of DII 
COE Kernel v 4.2.0.0”. Press [Return]. 

 
The system reboot at this time. 
 
 Note:  Depending on your systems configuration you may be required to enter your firmware password. 
 
 
Once the system is finished rebooting the DII COE login screen will appear.  Login as sysadmin. 
 
Do not proceed with any other steps until the “COE Login Processing is Compete” window appears, then 
click OK. 
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B. Installing DII COE 4.2.0.0 Kernel Patch 1 
 
Required Media: AFDI 1.1.0.1, for Solaris 7, 23 May 2001 
 
For additional guidelines on installing DII COE Kernel Patch 1, please review the AFDI UNIX Installation 
and Configuration Guide, Section 5.1.2.1 Installing the DII COE 4.2.0.0 Kernel Patch 1, page 78, located 
on the AFDI 1.1 CDROM 
 
Before installing the DII COE 4.2.0.0 Kernel Patch, you need to verify the sysadmin account is functioning 
properly. 
 

 From the CDE Panel, click on the Profile Selector icon (head with a “?”). 
 The "Profile Selector" window appears.  Select the “SA Default” profile in the ”Available Profiles” panel. 

Click the “>> (Add)” button to add the profile to the ”Selected Profiles” panel, then click the ”OK” 
button. 

 
Note:  The SA Default profile may already be listed in the Selected Profiles panel.  If it is already added, select added, 
select Cancel and skip the next step. 

 
 
 

 The ”Profile Selector Results” window appears. Click the ”Done” button. 
 Right-click on the desktop to display the ”Workspace Menu”.  Select ”Applications”, then 

“Application Manager”. 
 The “Application Manager” window appears. Double-click on the “DII_APPS” icon. 
 The “Application Manager DII_APPS” window appears. Double-click on the “SysAdm" icon. 
 The “Application Manager – SysAdm” window appears.  Icons assigned to the “SA Default” profile are 

displayed in the window. 
 

Note:  If you can get to this point without any problems, the sysadmin account should be functioning just fine.  
 

 To begin installing the DII COE 4.2.0.0 Kernel Patch 1 Segment, double-click on the "Segment 
Installer" icon. 

 
  

 
 

 
 
 

Note:  The installer displays all segments that are currently loaded on the system.  Release Notes for any installed
segment can be viewed by highlighting the segment and then clicking the "Release Notes" button. 
 The " Installer" window appears.  Ensure the AFDI 1.1 CD is in the CDROM Drive, then click on the 
"Select Source" button. 

 The "Select Source" window appears.  Select the "CDROM" button. 
 The “Select File” window appears.  From the files scroll area select "coepatch.tar", then click OK. 
 The " Installer" window appears.  Select the "Read Contents" button. 
 In the lower windowpane of the Segment Installer window, highlight the "DII-COE 4.2.0.0 Kernel 

Patch 14.2.0.0P1" segment, then click the "Install" button. 
 You will be prompted for a password.  Enter the APM Authentication Key password you set during 

the DII COE Installation and click OK. 
 When prompted, click OK to reboot the system in order to complete the installation of the DII COE 

Kernel Patch. 

Note:  The system reboots at this time.  After the system reboots, login as sysadmin. 

                                                                                                                               D-52 



Broadsword-3.1-SYSIMG-20 Sept 02 
FINAL 

 
C. Installing TCP Wrappers 
 
Required Media: AFDI 1.1.0.1, for Solaris 7, 23 May 2001 
 
For additional guidelines on installing AFDI, please review the AFDI UNIX Installation and Configuration 
Guide, Section 5.1.2.2 AFDI Installation Overview, page 78, located on the AFDI 1.1 CDROM 
 

 Right-click on the desktop to display the ”Workspace Menu”.  Select ”Applications”, then 
“Application Manager”. 

 The “Application Manager” window appears. Double-click on the “DII_APPS” icon. 
 The “Application Manager DII_APPS” window appears. Double-click on the “SysAdm. 
 The “Application Manager – SysAdm” window appears.  Icons assigned to the “SA Default” profile are 

displayed in the window. 
 To begin installing the TCP Wrappers Segment, double-click on the "Segment Installer" icon. 

 
  

 
 

 

 

Note:  The installer displays all segments that are currently loaded on the system.  Release Notes for any installed
segment can be viewed by highlighting the segment and then clicking the "Release Notes" button. 
 The " Installer" window appears.  Ensure the AFDI 1.1 CD is in the CDROM Drive, then click on the 
"Select Source" button. 

 The "Select Source" window appears.  Select the "CDROM" button. 
 The “Select File” window appears.  From the files scroll area select "tcpwrapr.tar", then click OK 
 The "Segment Installer" window appears.  Select the "Read Contents" button. 
 In the lower windowpane of the Segment Installer window, highlight the "TCP Wrappers" segment, 

then click the "Install" button. 
 You will be prompted for a password.  Enter the APM Authentication Key password you set during 

the DII COE Installation and click OK. 
 A message will appear stating: 

"Installation is completed.  Log will be kept in the /var/log/syslog file.  In order to modify the 
access restrictions, refer to the /h/COE/Comp/TCPW/data/README.txt file."   

 Click OK to complete the installation of TCP Wrappers. 
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D. Installing AFDI 1.1.0.1 for Solaris 7 
 
Required Media: AFDI 1.1.0.1, for Solaris 7, 23 May 2001 
 
For additional guidelines on installing AFDI, please review the AFDI UNIX Installation and Configuration 
Guide, Section 5.2.1 Fresh Install, page 82, located on the AFDI 1.1 CDROM 
 

Note:  If you have not exited the Segment Installer window, skip the next 5 steps.  
 

 Right-click on the desktop to display the ”Workspace” menu.  Select ”Applications”, then 
“Application Manager”. 

 The “Application Manager” window appears. Double-click on the “DII_APPS” icon. 
 The “Application Manager DII_APPS” window appears. Double-click on the “SysAdm” icon. 
 The “Application Manager – SysAdm” window appears.  Icons assigned to the “SA Default” profile are 

displayed in the window. 
 To begin installing the AFDI 1.1.0.1 Segment, double-click on the "Segment Installer" icon. 

 
 Note:  The installer displays all segments that are currently loaded on the system.  Release Notes for any installed 

segment can be viewed by highlighting the segment and the clicking the "Release Notes" button.  
 

 The "Installer" window appears.  Ensure the AFDI 1.1 CD is in the CDROM Drive, then click on the 
"Select Source" button. 

 The "Select Source" window appears.  Select the "CDROM" button. 
 
 Note:  Although CDROM may already to selected, you MUST click on CDROM again to bring up the list of files on 

the CD-ROM.  
 

 The “Select File” window appears.  From the files scroll area select "sol-afdi.tar", then click OK. 
 The "Installer" window appears.  Select the "Read Contents" button. 
 In the lower windowpane of the Segment Installer window, highlight the "AF DoDIIS 

Infrastructure" segment, then click the "Install" button. 
 You will be prompted for a password.  Enter the APM Authentication Key password you set during 

the DII COE Installation and click OK. 
 

Note:  If you did not exit the Segment Installer window, this will not appear.  
 

 The "Pre AFDI Configuration" window appears. 
 When prompted, "Do you wish to run the Automated Configuration Script?", enter y. 
 When prompted, "Do you have an existing Pre-AFDI configuration file prepared?", enter n. 
 When prompted, "Choose Security Mode: (enter choice):", enter a for command. 

 
Note:   

• When changing the security mode from "none" to "command" or "full", the administrator will be prompted 
for the password to be used and will be asked for verification. 

• The PROM monitor MUST have a security mode of at least "command" 
• If the security mode is set to "command", a password is required for all PROM commands except for the 

"boot" (b) and "continue" (c) commands.  If the security mode is set to "full", a password is required for all 
PROM commands except the "continue" (c) command.

 
 
 
 
 
 
 
 

 When prompted, "Do you wish to allow non-console root logins?", enter n. 
 

Note:  This is a troubleshooting recommendation.  Until the network services are all verified as operational, remote 
access as root may be required to allow troubleshooting of network configuration problems.  Having root login 
restricted to console access provides higher security.  Answer "y" to allow root remote login to the workstation being 
installed. 

 
 
 
 

                                                                                                                               D-54 



Broadsword-3.1-SYSIMG-20 Sept 02 
FINAL 

 
 

 You will receive a message stating "The default AFDI Audit Flags are (lo,fr,pc,fd,ad)" Then you will 
be prompted, "Do you wish to use these?", press [Return] to accept the default of yes. 

 When you are prompted, "Do you wish to enter any more flags?", press [Return] to accept the default 
of no. 

 When prompted, "Do you wish to enter any naflags?", press [Return] to accept the default of no. 
 When prompted, "Choose a naming service: (enter choice):", type c for local. 
 When prompted, "Enter NIS/NIS+ domain name:", type a name in.  The system will not function 

properly if this field is left blank.           
 

IE.  broadsword.server 
 

 When prompted, "Choose the home directory mount type: (enter choice):", type a for auto mounting. 
 When prompted, "Is this host a home directory server?", type y. 

 
  
 
 

 
 
 
 
 
 
 

 
T
(S
Note:  You must select y it the machine you are installing is a stand-alone server or if it really is the home director
server.  
 When prompted, "Enter the home directory mount point that clients of `hostname` will use 
[/h/USERS/global/`hostname`]" press [Return] 

 When prompted, "Enter any additional home directory servers below.  When finished, press enter on a 
empty line to exit home directory server:", press [Return] 

 You will receive the message, "Enter in the hostname of the home directory clients for `hostname`, one 
per line.  When finished, press enter on an empty line to exit. `hostname` home directory client:", press 
[Return] 

 When prompted, "Is this host a Mail Hub? (Answer "y" if a "Local" machine)", type y. 
 You will receive a message, "Enter the hostname of the mail clients for `hostname`, one per line.  

When finished, press enter on an empty line to exit.  `hostname` mail client:", press [Return] 
 When prompted, "Enter root mail alias destination: [cisso@mailhost]", press [Return] 
 When prompted, "Enter isso mail alias destination: [cisso@mailhost]", press [Return] 
 When prompted, "Enter admin mail alias destination: [cadmin@mailhost]", press [Return] 
 When prompted, "Enter operator mail alias destination: [coper@mailhost]", press [Return] 
 When prompted, "Do you want to configure network printer?", type n 
 When prompted, "Do you want to install SPI-Net after the AFDI installation completes?", type y 
 You will now be given an opportunity to change and of the items you have just configured. 
 You will be prompted, "Enter the menu number of the variable you wish to change, or "q" to quit 

editing: [q]".  If you do not see any problems with the information you have entered then press 
[Return] to accept the default of quit. 

 When prompted, "Do you wish to proceed with the configuration?", type y 
 You will be prompted, "Set security password: Changing PROM password: New Password:" enter the 

new password. 

Note:  BE SURE TO WRITE THIS PASSWORD DOWN IN A SECURE LOCATION WHERE MORE 
THAN ONE PERSON MAY ACCESS IT.  IF YOU LOSE THIS PASSWORD THE SYSTEM WILL HAVE 
TO BE SENT BACK TO SUN TO BE RESET.  THERE IS NO SYSADMIN MAGIC TO RECOVER A LOST 
PROM PASSWORD. 

 When prompted, "Retype new password:" re-enter the new password from the previous step. 
 An information message will appear stating, "Press enter to continue the installation.",  press [Return] 

he software installs at this time and takes about 2 minutes.  Then the “AFDI 1.1.0.1 Administration 
olaris)” window appears.  You are now ready to Configure AFDI.  Proceed to the next section. 
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E. Configuring AFDI 1.1.0.1 for Solaris 7 
 
Required Media: AFDI 1.1.0.1, for Solaris 7, 23 May 2001 
 
For additional guidelines on configuring AFDI, please review the AFDI UNIX Installation and 
Configuration Guide, Section 5.3.1 Fresh Install, page 92, located on the AFDI 1.1 CDROM 
 

 The "AFDI V1.1.0.1 Administration (Solaris)" window appears. Click on the User Account icon. 
 The "AFDI V1.1.0.1 Administration – User Account" window appears. Click cisso, then enter the appropriate 

information in the following text boxes: 
 

 Password 
 Verify Password 
 Home Directory = /h/USERS/local/cisso 
 Login Directory = /h/USERS/local/cisso 
 Shell = /bin/sh 

 
 Then click yes to create user account.  When the dialog box stating cisso Created appears, click OK. 
 Click cadmin, then enter the appropriate information in the following text boxes: 

 
 Password 
 Verify Password 
 Home Directory = /h/USERS/local/cadmin 
 Login Directory = /h/USERS/local/cadmin 
 Shell = /bin/sh 

 
 Then click yes to create user account.  When the dialog box stating cadmin Created appears, click OK. 
 Click coper, then enter the appropriate information in the following text boxes: 

 
 Password 
 Verify Password 
 Home Directory = /h/USERS/local/coper 
 Login Directory = /h/USERS/local/coper 
 Shell = /bin/sh 

 
 Then click yes to create user account.  When the dialog box stating coper Created appears, click OK. 
 Click on the Role (TFM Group) icon. 
 The "AFDI V1.1.0.1 Administration – Role (TFM Group)" window appears. Click isso. 
 Click Yes to create role account now.   When the dialog box stating Role isso created, click OK. 
 Click dadmin. 
 Click Yes to create role account now.   When the dialog box stating Role dadmin Created, click OK. 
 Click oper. 
 Click Yes to create role account now.   When the dialog box stating Role oper Created, click OK. 
 Click on the TFM Privilege icon. 
 The "AFDI V1.1.0.1 Administration – TFM Privilege" window appears then immediately afterwards 

the "Select A Role" window appears. Highlight isso, then click OK. 
 The " AFDI V1.1.0.1 Administration – TFM Privilege " window appears.  Click ISSO. 
 Click Yes. When the "Role ISSO Updated" window appears, click OK. 
 The "Select A Role" window appears. Highlight dadmin, then click OK. 
 The " AFDI V1.1.0.1 Administration – TFM Privilege " window appears.  Click Administrator. 
 Click Yes. When the "Role dadmin Updated" window appears, click OK. 
 The "Select A Role" window appears. Highlight oper, then click OK. 
 The " AFDI V1.1.0.1 Administration – TFM Privilege " window appears.  Click Operator. 
 Click Yes. When the "Role oper Updated" window appears, click OK. 
 The "Select A Role" window appears.  Click Cancel. 
 The "AFDI V1.1.0.1 Administration" window appears. Click on the Network Port icon. 
 The "AFDI V1.1.0.1 Administration – Network Port" window appears. Click Yes. 
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 The "Service Updates" dialog appears.  Click OK, then click on the Return to Main Menu icon. 
 The "AFDI V1.1.0.1 Administration" window appears. From the "File" menu, select "Exit & Run 

Setup". 
 A "Exit AFDI V1.1.0.1Administration" window appears. Click Yes. 
 A "AFDI Diagnostic Configuration" window appears. Correct any errors seen here, and then click OK. 

 
 Note:  Consult the AFDI UNIX ICG for details on how to correct any errors that may appear.  
 

 A message appears asking to Abort or Continue. Click Continue. 
 The "AFDI V1.1.0.1 Setup" window appears.  Click on the Remote Development Software icon. 
 The "AFDI V1.1.0.1 Setup – Remote Development Software" window appears.  No changes are 

required at this time.  Click on the Environment icon. 
 The "AFDI V1.1.0.1 Setup – Environment" window appears.  No changes are required at this time.  

Click on the XDISPLAY Manager (XDM) icon. 
 The "AFDI V1.1.0.1 Setup – XDISPLAY Manager (XDM)" window appears.  There should be no 

changes required here. Click on the Network Services icon. 
 The "AFDI V1.1.0.1 Setup – Network Services" window appears. In the section labeled "AFDI 

Administration - Type" click on Server. 
 In the section labeled "Network Time Protocol Type" click on Client then enter the appropriate 

information for the NTP Server Name.   
 

 For the Internet refer to http://tycho.usno.navy.mil/frtime.html, select the link for “Setting 
your computer to USNO time”, then pick the “Network Time Protocol (NTP)”  link to find an 
appropriate time server. 

 For the SIPRNet refer to http://www.ismc.sgov.gov.  On the main page, there is a Support 
section.  Under this section there is a link to “Time Servers/Time Software.”  Follow this link, 
then follow the link on the next page to find the location of the time servers on SIPRNet. 

 For JWICS refer to http://www.ic.gov.  On the main page, there is a Support section.  Under 
this section there is a link to “Time Servers/ Time Software.”  Follow this link, then follow 
the link on the next page to find the locations of the time servers on JWICS. 

 
 Click on the ISD Daemon Configuration icon. 
 The "AFDI V1.1.0.1 Setup – ISD Daemon Configuration" window appears.  Ensure the hostname of 

your machine is entered in each of the fields, and then click on the Print Banners icon. 
 The "AFDI V1.1.0.1 Setup – Print Banners" window appears.  In the text boxes provided, fill out the 

appropriate information in the items marked: 
 

 Service Branch 
 Organization 
 Location 

 
 Click on the Security Labels icon. 
 The "AFDI 1.1.0.1 Setup – Security Labels" window appears. In the text box marked "Classification", 

enter a classification level that is allowed to be processed on the system, then click on the "Add 
Classification" button.  Be sure also to enter any applicable codewords, caveats and handling 
instructions that may be applicable for the security level of the machine. 

 
Note:  Repeat this step until all permitted classifications are entered for the system.  

 
 Enter the appropriate information in the text boxes labeled: 

 
 System High Label 
 System High Short Label 

 
 Click on the Centralized Log/Audit Support Subsystem icon. 
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 The "AFDI V1.1.0.1 – Centralized Log/Audit Support Subsystem" window appears. 
 In the text box labeled "Server Name" enter the hostname of the server. Select Yes for "Enable Server 

Daemon".  In the test box labeled "Archive Device" type /dev/null and then click on the DNS 
Resolver icon. 

 The "AFDI V1.1.0.1 Setup – DNS Resolver" window appears.  For "Type" select Client.  Enter in the 
appropriate information for the following items: 

 
 DNS Domain 
 IP Address of Primary Name Server 
 P Address of Secondary Name Server (Optional) 
 IP Address of Secondary Name Server (Optional) 

 
 When you are finished entering the appropriate information click on the Return to Main Menu icon. 
 The "AFDI V1.1.0.1 Setup" window appears. From the "File" menu, select "Save & Execute". 

 
Note:  Configuration changes are implemented at this time.  

 
 The "AFDI V1.1.0.1 Setup- Log" window appears.  Correct any errors, and then click "Close" 
 The "AFDI V1.1.0.1 Setup" window appears. From the "File" menu, select "Exit". 
 The "Exit AFDI V1.1.0.1 Setup" dialog box appears. Click Yes. 
 A "Map Name Dialog" window appears. In the text box labeled "Map Name", type the systems 

hostname followed by _local. 
 
  IE.  `hostname`_local 
 
 
 
 

 

 

 

 

 
 
 

Note:  Where `hostname` is used, type the actual hostname of the server vice `hostname` and be sure NOT to 
include the ` marks. 
 Next to "Map Type" click "Local", then click "OK". 
 The "AFDI V1.1.0.1 Map Administration" window appears. Click on the Distribution icon.  
 The "AFDI V1.1.0.1 Map Administration – Distribution" window appears. Select all databases under 

"Target Databases". 
 For "Target OS", select Solaris, then click on the Defaults icon. 
 The "AFDI V1.1.0.1 Map Administration – Defaults" window appears.  For each of the text boxes 

provided enter the appropriate data as follows: 

 UserID   min  200  max  499 
 GroupID                  min  200  max  499 
 Password Aging:  min  0  max  90  warning  14 
 Login Group                      bswd 
 Home Directory Parent /h/USERS/local/`hostname` 
 Login Directory Parent /h/USERS/local/`hostname` 
 Shell   /bin/csh 

 Change the following items to your command's information: 

 Office 
 Office Phone 
 Organization 

 Click on the Initial Population icon. 
 The "AFDI V1.1.0.1 Map Administration – Initial Population" window appears. Click on local for all 

entries, then click on the Return to Main Menu icon. 
 The "AFDI V1.1.0.1 Map Administration" window appears. From the Map menu, select Create. 

Note:  AFDI Populates at this time. 
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 The “AFDI V1.1.0.1 Map Adminstration – Log” window appears.  Click Close. 
 From the Map menu, select Exit. 
 The “Exit AFDI V1.1.0.1 Map Administration” window appears. Click Yes. 

 
The Basic AFDI functionality is now competed.  To compete the AFDI Installation and Configuration 
Process, proceed to the next section to install and configure SPI-Net. 
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F. Installing SPI-NET for Solaris 7 
 
Required Media: AFDI 1.1.0.1, for Solaris 7, 23 May 2001 
 
For additional guidelines on configuring AFDI, please review the AFDI UNIX Installation and 
Configuration Guide, Section 5.3.5.1, page 135, located on the AFDI 1.1 CDROM 
 
Once you have completed the AFDI configurations the installation process will continue. 
 

 The "SPINET Installation" window appears. 
 When prompted, "Do you want this workstation to be a Command Host or a Remote Host?" type c 

<cr> 
 When prompted, "You have selected Command Host.  Is this Correct?" press [Return] to accept the 

default yes. 
 The "License Agreement" window appears.   
 When prompted, "If you accept the conditions described above, please enter yes.  Otherwise enter no 

[y]" press [Return] 
 When prompted, "Hit return to continue this installation or Enter n to exit:" press [Return] 
 When prompted, "Please enter the full SPI-NET Command Host name. (ie xxx.llnl.gov)" enter the 

machines fully qualified host name.    
 

IE.  earnhardt.langley.af.smil.mil 
 

 When prompted, "Is this correct?" press [Return] 
 When prompted, "Do you wish to take the CDT snapshot now?" press [Return] 

 
Note:  SPI-NET installs at this time and only takes a few moments to complete.  

 
 The "Installer" window appears at this time.  Click Exit 

 
Reboot the server by typing init 6 at the root prompt. 
When the system finishes rebooting login as cisso. 
 
In order for SPI-Net to function properly, several post-installation configurations will need to be made.  
The best procedures for this are found beginning on page 138 of the AFDI Unix Installation and 
Configuration Guide.  Refer to this now to configure SPI-Net. 
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G. AFDI Boot Utility Fix for Solaris 7 
 
Required Media: None 
 
If you choose to use the Boot Utility provided by AFDI you will need to run the following procedures to 
make this possible. 
 
This item corrects an error received when attempting to halt or reboot the system using the Boot Utility on 
the ISSO Panel.  The solution was provided by the AFDI Help Desk for the following error: 
 
           Unable to reboot `hostname` 
           Connection to `hostname` broken: 
           RPC: Unable to receive; An event requires attention. 
 
If you receive this error, perform the following steps: 
 

Note:  You must be user root to perform these steps (unless specified otherwise).  
 
 

 At the command prompt as root verify rpc is functioning by typing: 
 

rpcinfo –t `hostname` isd 
 
 
 

Note:  Where `hostname` equates to the actual hostname of your system.  Do not include the ` marks. 

 If this works you should receive a message saying that it is ready and waiting. 
 Next you need to verify the isd.conf file is configured correctly. 

 
cd /h/AFDI/config 

 
 Then edit the isd.conf file: 

 
vi isd.conf 

 
Once in the file you will verify/correct the following information: 
 

 Ensure the following entries equal your machines hostname. 
 

DISK_SPACE=`hostname` 
       PROCESS_MANAGEMENT=`hostname` 
       BOOT_UTILITY=`hostname` 
       ARCHIVE_UTILITY=`hostname` 
       TERMINAL_EMULATOR=`hostname` 
       USER_GRP_MAINTENANCE=`hostname` 
       USER_ACCT_INFO=`hostname`=`hostname` 
 
 
 

Note:  Where `hostname` equates to the actual hostname of your system.  Do not include the ` marks. 

 Ensure the following lines are commented (#) out.  They should appear as shown below: 
 

#USER_IDS_RANGE= 
       #GROUP_IDS_RANGE= 
       #USER_IDS= 
       #GROUP_IDS= 
 

 Once this is completed you should be able to use the Boot Utility function. 
 

                                                                                                                               D-61 



Broadsword-3.1-SYSIMG-20 Sept 02 
FINAL 

 
14.) Installing the Java Runtime Environment (JRE) v 1.3.1 
 
Prior to the installation of the TTA v1.0.2 software on the TTA platforms the Java Runtime Environment 
(JRE) v 1.3.1 needs be installed in order to support the configuration of the TTA system. This installation 
should be performed in accordance with the following steps.  The time required to perform these steps is 
approximately 15 minutes. 
  

 Login to the workstation as a System Administrator who has permission to “su” to root. 
 Open a terminal window and “su” to root by executing the following command: 

 
% su – 
 

 In the terminal window, change the current working directory to the /usr directory by executing the 
following command: 

 
        # cd /usr 
 

 In the terminal window, execute the following command to copy the self-extracting binary from the 
java directory located on the TTA Installation CD-ROM by executing the following command: 

 
       # cp <CD-ROM Mount Point>/java/j2re-1_3_1_02-solsparc.sh . 

 
 Make sure that the execute permissions are set on the self-extracting binary file by executing 

the following command: 
 

       # chmod +x j2re-1_3_1_02-solsparc.sh 
 

 Run the self-extracting binary by issuing the following command: 
 

       # ./j2re-1_3_1_02-solsparc.sh 
 
A directory called j2re1_3_1_02 will be created in the /usr directory. 
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15.) Installing the IONA Orbix 3.3.2 Software 
 
Required: Jumbo Travel Disc for Broadsword Installers CD 
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Note:  You must be user root to perform these steps (unless specified otherwise).  It is only necessary to load the 
IONA Orbix software if the system will interface with an IPL 3.0.  It is not necessary to load the IONA Orbix  
software if Broadsword is co-hosted on an IPL 3.0.
sert the CD into the CDROM drive and boot the system from the CDROM Drive.   

boot cdrom<cr> 

 may take a few minutes for the initial screen to appear. 

he location where the Orbix software is installed is dependent on the security environment of the system.  

or CSE-SS environment: 

stall the IONA Orbix software: 

cp /cdrom/cdrom0/Orb.tar.gz /opt/ 
cd /opt 
gunzip Orb.tar 
tar xvpf Orb.tar 

NA Orbix software installation is complete. 

or AFDI environment: 

stall the IONA Orbix software: 

cp /cdrom/cdrom0/Orb.tar.gz /h/COTS/ 
cd /h/COTS  
gunzip Orb.tar 
tar xvpf Orb.tar 

odify IONA Orbix environment files for use with AFDI.   

dit the /h/COTS/iona/setenvs.csh file and modify the IONA_ROOT variable as follows: 

setenv IONA_ROOT /h/COTS/iona 

dit the /h/COTS/iona/setenvs.sh file and modify the IONA_ROOT variable as follows: 

IONA_ROOT=/h/COTS/iona ; export IONA_ROOT 

or both environments: 

btain the IPL 3.0 site name: 

/opt/bswd3.1/bin/GetIplLpaNames.csh 

ote the IPL 3.0 site name for use when configuring the IPL 3.0 plugin. 
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16.) General Trouble-Shooting & Miscellaneous 

 
Running Broadsword in the Verbose Mode 
 
It is often useful to run the Gatekeeper and/or individual plugins in the verbose mode in order to isolate and 
resolve configuration/communication problems.  Each Broadsword local backside source that is configured 
will have an accompanying process (daemon) that is started when Broadsword (startserver) is started.  
All remote sources use the remote_plugin.SVR4 for communication. 
 

Note:  You must be user root to perform these steps (unless specified otherwise).  
 
 To run the Gatekeeper in verbose mode: 

 
# csh<cr> 
# ps –ef | grep gatekeeper.SVR4<cr> 
# kill PIDs<cr> 
# ps –ef | grep gatekeeper.SVR4<cr> 
# source /opt/bswd3.1/etc/server_env_vars<cr> 
# setenv SYBASE /opt/bswd3.1/odbc<cr> 
# cd /opt/bswd3.1/bin 
# strings gatekeeper.SVR4|grep _DEBUG_ 
Several DEBUG variables will be displayed.  Note all unique occurrences of these DEBUG variables and 
perform a setenv for each.  The next line is given as an example. 
# setenv _DEBUG_ <cr> 
# /opt/bswd3.1/bin/gatekeeper.SVR4<cr> 

 
 To run individual plugins in verbose mode: 

 
# csh<cr> 
# ps –ef | grep backsidesource_plugin.SVR4<cr> 
# kill PIDs<cr> 
# ps –ef | grep backsidesource_plugin.SVR4<cr> 
# source /opt/bswd3.1/etc/server_env_vars<cr> 
# source /opt/bswd3.1/plugins/backsidesource/env_vars<cr> 
# cd /opt/bswd3.1/bin 
# strings backsidesource_plugin.SVR4|grep _DEBUG_ 
Several DEBUG variables will be displayed.  Note all unique occurrences of these DEBUG variables and 
perform a setenv for each.  The next line is given as an example. 
# setenv _DEBUG_ <cr> 
# /opt/bswd3.1/bin/backsidesource_plugin.SVR4<cr> 

 
The backside sources can be found in the /opt/bswd3.1/bin directory. 
 
 To run conan in verbose mode: 

 
# csh<cr> 
# ps –ef | grep conan<cr> 
# kill PIDs<cr> 
# ps –ef | grep conan<cr> 
# source /opt/bswd3.1/etc/server_env_vars<cr> 
# cd /opt/bswd3.1/bin 
# strings conan|grep _DEBUG_ 
Several DEBUG variables will be displayed.  Note all unique occurrences of these DEBUG variables and 
perform a setenv for each.  The next line is given as an example. 
# setenv _DEBUG_ <cr> 
# /opt/bswd3.1/client/bin/startconan<cr> 
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Changing the gid for the bswd Group 
 
Broadsword requires the bswd group to have a unique gid.  The BSWD PMO typically used a gid of 60 
for the bswd group unless the site specifies otherwise.  Occasionally, it is necessary to change the gid for 
the bswd group after the system has been installed to avoid a conflict with an existing site gid.  The 
following procedure can be used to change the gid for the bswd group. 
 
Edit the /etc/groups file (or update the NIS/NIS+ map) and change the bswd group to oldbswd. 

 
# cd /opt/bswd3.1<cr> 
# find . –group oldbswd –print | xargs chgrp bswd<cr> 

 
 
Changing IP address and hostname 
 
Scripts required: ChangeIPAddressonUltra80.sh 
  ChangeHostNameonUltra80.sh 
 
Ideally, IP address and hostname are assigned during the operating system install.  However, it is 
sometimes necessary to change the IP address and hostname after the system has arrived at the site.  To 
change the IP address and hostname, perform the following procedure. 
 

Note:  You must be user root to perform these steps (unless specified otherwise).  
 
Bring down the Broadsword server: 
 

# /opt/bswd3.1/scripts/stopserver<cr> 
 
As user sybase, change the IP address in the Sybase interfaces file: 
 

# su – sybase<cr> 
% csh<cr> 
% setenv SYBASE /opt/SYBASE<cr> 
% setenv DISPLAY localhost:0.0<cr> 
% /usr/openwin/bin/xhost localhost<cr> 
% /opt/SYBASE/bin/dsedit<cr> 

 
 In the “dsedit – Select a directory service” window, select the “Sybase interfaces file” entry 

(if not already selected) from the “Select a directory service to open:” scroll area and click 
“OK”. 

 In the “dsedit – Directory Service Session” window, select the  “BSWD_hostname_SVR” 
entry from the “Available servers:” scroll area and click “Modify server entry”. 

 In the “dsedit – Server Entry Editor” window, select the  “tli tcp: hostname 2503” entry from 
the “Available network transports:” scroll area and click “Modify network transport”. 

 In the “dsedit – Network Transport Editor” window, enter the  new IP address in the “Host 
Name:”  text box and click “OK”. 

 In the “dsedit – Select a directory service” window, select the “Sybase interfaces file” entry 
(if not already selected) from the “Select a directory service to open” scroll area and click 
“OK”. 

 In the “dsedit – Directory Service Session” window, select the  “SYB_BACKUP” entry from 
the “Available servers:” scroll area and click “Modify server entry”. 

 In the “dsedit – Server Entry Editor” window, select the  “tli tcp: hostname 2653” entry from 
the “Available network transports:” scroll area and click “Modify network transport”. 

 In the “dsedit – Network Transport Editor” window, enter the  new IP address in the “Host 
Name:”  text box and click “OK”. 
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 In the “dsedit – Network Transport Editor” window, enter the  new IP address in the “Host 

Name:”  text box and click “OK”. 
 In the “dsedit – Select a directory service” window, click “Exit”. 
 When prompted “Are you sure you want to exit”, click “Yes”. 

 
Exit from the sybase user account back to root: 
% exit<cr> 
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As user root, edit the IP address script.  This script must contain the current IP address of the Broadsword 
server (i.e. the IP address that you want to change will be hard coded in this script).  Verify that the script 
contains the current IP address, otherwise modify all occurrences of the IP address to reflect the current IP 
address.  Run the change IP address script with the new IP address as the argument:   
 
# cd /home/bswdserv/bswduser<cr> 
# ./ChangeIPAddressonUltra80.sh 1st-octet 2nd-octet 3rd-octet 4th-
octet<cr> 
 
Where the four octets of the IP address are <spacebar> delimited.  For example: 
 

# ./ChangeIPAddressonUltra80.sh 128 132 42 14<cr> 
 
As user root, edit the hostname script.  This script must contain the current hostname of the Broadsword 
server (i.e. the hostname that you want to change will be hard coded in this script).  Verify that the script 
contains the current hostname, otherwise modify all occurrences of the hostname to reflect the current 
hostname.  Run the change hostname script with the new hostname and fully qualified domain name as the 
arguments:   
 
# cd /home/bswdserv/bswduser<cr> 
# ./ChangeHostNameonUltra80.sh new_hostname fully_qualified_domain_name<cr> 
 
For example: 
 

# ./ChangeHostNameonUltra80.sh bswdservnew ird.rl.af.mil<cr> 
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	Two 9 GB Drives
	
	NOT USED


	Two 18 GB Drives
	
	NOTE USED


	One 9 GB Drive and One 18GB Drive
	Four 9 GB Drives
	Four 18 GB Drives

	5.) Sample TTA Gatekeeper Disk Partitions
	One 18 GB Drive
	Two 9 GB Drives
	
	NOT USED
	NOT USED
	NOT USED


	Two 18 GB Drives
	
	NOT USED
	NOT USED
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	The following significant changes are made to the system once DII COE is installed:
	
	
	# cd /cdrom/cdrom0








